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Preface

The Java Enterprise System Installation Guide for Microsoft Windows contains instructions for
installing the Sun JavaTM Enterprise System (Java ES) software in the Microsoft Windows
Operating System.

Who Should Use This Book
The material here is intended for any evaluator, system administrator, or software technician
who wants to install the Java ES software. This guide assumes you are familiar with the
following:

■ Installation of enterprise-level software products
■ System administration and networking on your supported Java ES platform

Java ES Documentation Set
The Java ES documentation set describes deployment planning and system installation. The
URL for system documentation is http://docs.sun.com/app/docs/coll/1259.2. For an
introduction to Java ES, refer to the books in the order in which they are listed in the following
table.

TABLE P–1 Java ES Documentation

Document Title Contents

Sun Java Enterprise System 5 Release Notes for
Microsoft Windows

Contains the latest information about Java ES,
including known problems. In addition, components
have their own release notes.

Sun Java Enterprise System 5 Technical Overview Introduces the technical and conceptual foundations
of Java ES. Describes components, the architecture,
processes, and features.
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TABLE P–1 Java ES Documentation (Continued)
Document Title Contents

Sun Java Enterprise System 5 Deployment Planning
Guide

Provides an introduction to planning and designing
enterprise deployment solutions based on Java ES.
Presents basic concepts and principles of deployment
planning and design, discusses the solution life cycle,
and provides high-level examples and strategies to use
when planning solutions based on Java ES.

Sun Java Enterprise System 5 Installation Planning
Guide

Helps you develop the implementation specifications
for the hardware, operating system, and network
aspects of your Java ES deployment. Describes issues
such as component dependencies to address in your
installation and configuration plan.

Sun Java Enterprise System 5 Installation Guide for
Microsoft Windows

Guides you through the process of installing Java ES
on the Microsoft Windows operating system. Also
shows how to configure components after installation,
and verify that they function properly.

Sun Java Enterprise System Glossary Defines terms that are used in Java ES documentation.

Communications Products
Sun Microsystems has decided to exclude the communication products from the Sun Java
Enterprise System entitlement.

Beginning with the current release 5, communication products will be available as part of the
Sun Java Communications Suite; or as individual products. Communication products will no
longer be installed through the Java Enterprise System installer.

Communication products affected include:

■ Sun Java System Messaging Server
■ Sun Java System Calendar Server
■ Sun Java System Instant Messaging

This change in entitlement does not affect the previously shipped communication products in
Java Enterprise System 2005Q4. If you have communication products installed, no change will
occur to your current entitlement.

Preface
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Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–2 Typographic Conventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and directories,
and onscreen computer output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 A placeholder to be replaced with a real name or
value

The command to remove a file is rm
filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized (note that some emphasized items
appear bold online)

Read Chapter 6 in the User's Guide.

A cache is a copy that is stored
locally.

Do not save the file.

Shell Prompts in Command Examples
The following table shows default system prompts and superuser prompts.

TABLE P–3 Shell Prompts

Shell Prompt

C shell on UNIX systems machine_name%

C shell superuser on UNIX systems machine_name#

Bourne shell and Korn shell on UNIX systems $

Bourne shell and Korn shell superuser on UNIX systems #

Microsoft Windows command line C:\

Preface
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Symbol Conventions
The following table explains symbols that might be used in this book.

TABLE P–4 Symbol Conventions

Symbol Description Example Meaning

[ ] Contains optional arguments
and command options.

ls [-l] The -l option is not required.

{ | } Contains a set of choices for a
required command option.

-d {y|n} The -d option requires that you use
either the y argument or the n
argument.

${ } Indicates a variable reference. ${com.sun.javaRoot} References the value of the
com.sun.javaRoot variable.

- Joins simultaneous multiple
keystrokes.

Control-A Press the Control key while you press
the A key.

+ Joins consecutive multiple
keystrokes.

Ctrl+A+N Press the Control key, release it, and
then press the subsequent keys.

→ Indicates menu item selection
in a graphical user interface.

File → New → Templates From the File menu, choose New.
From the New submenu, choose
Templates.

Documentation, Support, and Training
The Sun web site provides information about the following additional resources:

■ Documentation (http://www.sun.com/documentation/)
■ Support (http://www.sun.com/support/)
■ Training (http://www.sun.com/training/)

Third-Party Web Site References
Third-party URLs are referenced in this document and provide additional, related information.

Preface
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Note – Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content, advertising,
products, or other materials that are available on or through such sites or resources. Sun will not
be responsible or liable for any actual or alleged damage or loss caused or alleged to be caused by
or in connection with use of or reliance on any such content, goods, or services that are available
on or through such sites or resources.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. To share your comments, go to http://docs.sun.com and click Send Comments.
In the online form, provide the full document title and part number. The part number is a seven
digit or nine digit number that can be found on the title page of the guide or at the top of the
document. For example, the part number of this book is 819-5699.

Preface
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Preparing for Java ES Installation

This chapter provides information that will help you install the Sun Java Enterprise System
(Java ES) software. Before starting the tasks documented in this guide, you should have already
planned your installation according to the Sun Java Enterprise System 5 Installation Planning
Guide. You should also be familiar with the reference material associated with Java ES
installation in Appendix B, “Default Directories and Ports.”

This chapter contains the following sections:

■ “How the Java ES Installer Works” on page 17
■ “Determining Whether Your Hosts Are Ready” on page 22
■ “Verifying General Installation Prerequisites” on page 23
■ “Windows Distribution Bundles” on page 24
■ “Obtaining the Java ES Software” on page 26

How the Java ES Installer Works
Sun Java Enterprise System (Java ES) integrates a number of Sun server-side products into a
system that provides the server software needed to support distributed enterprise applications.
In this document, these products are referred to as the Java ES product components. A single
installer is provided for installing the Java ES product components and shared components in
various combinations. Because of the complex interrelationships of these components,
installation requires much more preinstallation and postinstallation effort than is required to
install a single Java ES component.

Note – Portal Server on Windows can only be used as an evaluation platform or a developer
platform. It can not be used as a deployment platform. Do not use Java ES installer for Windows
to install Portal Server 7.1. Use the Zipinstaller to install Portal Server. The ReadMe file
provided with the installer has information on how to install Portal Server. Acess the Installer
from http://www.sun.com/download/products.xml?id=465e130d

1C H A P T E R 1
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The Zipinstaller provides you a pre-configured image of Sun Java System Portal Server 7.1
Update 1. You can get a working copy of Portal Server simply by unzipping the contents of this
file.

Java ES Components Used in This Release
ThisJava ES software release includes the following selectable Java ES components. The
abbreviated names used in this guide follow the name and version.

■ Access Manager 7.1
■ Application Server 8.2 Enterprise Edition (Application Server)
■ Directory Proxy Server 6.0
■ Directory Server Enterprise Edition 6.0 (Directory Server)
■ High Availability Session Store 4.4 (HADB)
■ Message Queue 3.7 UR1
■ Monitoring Console 1.0
■ JavaDB 10.2
■ Portal Server 7.1
■ Portal Server Secure Remote Access 7.1
■ Service Registry 3.1
■ Web Proxy Server 4.0.4
■ Web Server 7.0

To see the full list of services and subcomponents as displayed in the Java ES installer, refer to
Appendix A, “Java ES Components for This Release.” This appendix also lists the shared
components that are provided with this release.

Installer Modes
The Java ES Windows installer uses the Microsoft Windows Installer (MSI) framework to
install Java ES system on your host. You can install the Java ES software interactively or by
means of a reusable script.

■ Graphical Mode (Interactive). Provides an interactive graphical wizard that leads you
through the tasks of installing the Java ES software on a graphical workstation.

■ Silent Mode. Provides the option to run the installer on multiple hosts, each time using a
generated response file to specify an input to the installer. For silent mode installation, first
run the installer through a wizard while you save your responses as a set of name-value pairs
in a response file. For detailed information about the silent mode installation, refer to
Chapter 4, “Installing in Silent Mode.”

How the Java ES Installer Works
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Language Selection
The Java ES installer enables you to install multilingual packages for Java ES. The following
languages are available:

■ English
■ French
■ German
■ Japanese
■ Korean
■ Spanish
■ Simplified Chinese
■ Traditional Chinese

By default, the installer automatically installs Java ES in English language.

Setup Types
The Java ES installer enables you to select one of the following setup types:

■ Default. Selecting the Default setup type installs and configures all the Java ES components.
■ Custom. Selecting the Custom setup type allows you to select the Java ES components you

want to install.

Configuration Types and Parameter Settings
Many Java ES components require some degree of installation-time configurationdepening on
which Java ES components you select and which installation type you choose.

The following configuration types are available in the installer:

■ Configure Automatically During Installation: Use this option to evaluate the components
on a single host. During installation, you configure components that permit
installation-time configuration.
In this mode, the default values for the administrator user ID and Password are displayed
but these default settings can be modified during postinstallation. All other configuration
parameters such as port numbers are predetermined defaults presented at the end of
installation. These default values are used for configuring the components.

Note – The administrator user ID and password should not contain any special characters,
and the password should be eight or more characters long.

How the Java ES Installer Works
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■ Configure Manually After Installation: With this option during installation, you can
provide only the minimum values that are necessary for placing the software components in
their directories. Configuration is performed after installation.
When you select this option, the administrator settings dialog box is not displayed. Only the
files are copied during installation. You mustmanually edit the properties file with the
correct values. For more information about how to edit the properties file, refer to
Chapter 5, “Completing Postinstallation Configuration.”
If a component is dependent on other components, ensure that you configure the dependent
components first.

Depending on which configuration option you select, you might be required to provide the
administrator ID and password during installation. For example, most of the components
require you to specify an administrator user ID and password. By setting these common values,
you are setting default values for all component administrator user IDs and passwords.

Note – During Multi-Session installation of Java ES Components, the configuration mode,
Configure Automatically during Install or Configure Manually After Installation, selected in
first session install is taken as default in next successive sessions without prompting for
configuration selection mode screen.

Dependency Check
Many Java ES components depend on the presence of other components to provide their core
functions. The installer does extensive cross checking of Java ES components to verify that the
components you select during installation will function properly together. For this reason, the
installer might prompt you to include certain Java ES components as you make your
component selections.

The Java ES installer uses the following rules for handling dependencies among the Java ES
components:

■ Selecting a Java ES Component. When you select a Java ES component for installation, in
most cases the installer automatically selects all its subcomponents.
The installer also selects the components and subcomponents upon which the selected
component depends. For example, if you select Application Server, the installer
automatically selects Message Queue.

■ Deselecting a Java ES Component. If you deselect a Java ES component, in most cases the
installer automatically deselects all its subcomponents.
If you deselect a component that is required locally or remotely for another selected
component, the installer displays various warnings when you attempt to proceed.

How the Java ES Installer Works
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■ Selecting a Subcomponent. If you select a subcomponent, the installer automatically selects
the Java ES component to which the subcomponent belongs, but not the other
subcomponents.

If the selected subcomponent depends on other components or subcomponents, the others
are automatically selected.

■ Deselecting a Subcomponent. If you deselect a subcomponent, the installer deselects only
that subcomponent and not the other subcomponents.

If you deselect a subcomponent that is required locally or remotely for another selected
component, the installer displays various warnings when you attempt to proceed.

Upgrading
A Java ES component is upgraded by performing a fresh installation of the component by using
the Java ES installer. Perform a fresh installation by first removing the previous version's
packages and installing Release 5 in the same path. Alternatively, you can install Release 5 in a
parallel path, leaving the previous version intact.

In either case must reconfigure the component by migrating the previous version's
configuration data to the new installation, performing a new configuration, or doing a
combination of both. For some Java ES components an utility is provided for reconfiguring or
migrating configuration data for the component.

Java ES 5 Windows installer does not support in-place upgrade of previous versions of the
components. Instead, the installer supports coexistence with Java ES 4. After installing Java ES
5, you need to follow the upgrade procedure described in the Sun Java Enterprise System 5
Upgrade Guide for Microsoft Windows to upgrade Java ES components. Upgrade scenarios for
individual components are described in the respective upgrade guides.

When Java ES 5 installation is attempted, the installer first detects the presence of Java ES 4 on
the system. On successful detection, the installer checks for pre-existing Java ES 4 shared
components in the Windows SYSTEM directory, because these components cause
incompatibility issues with Java ES 5. If any of the shared components are being used by Java ES
4 services, you are prompted to stop the running Java ES 4 services.

In addition, the installer automatically renames the Java ES 4 shared components. The
renaming information is stored in the installer log file. If you need to start any of the Java ES 4
services, you should restore the names of shared components manually.

Note – Java ES 4 and Java ES 5 servers cannot be started simultaneously.

How the Java ES Installer Works
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Installation Logs
During the course of installation or uninstallation, log records are generated for the operations
that occur. These records are saved into a single file located at %Temp%\SUNJavaES.log.

Uninstalling
The configuration for all the products are removed before they are uninstalled. The scripts used
to remove the configuration are a part of the uninstallation program. You can uninstall the
Java ES system by choosing Start>Settings>Control Panel>Add/Remove Programsor by
running the uninstall program in Silent mode.

Determining Whether Your Hosts Are Ready
Before you start the installer, review the issues in this section.

System Requirements
Before you install Java ES, ensure that the hosts in your system meet the minimum hardware
and operating system requirements. For the latest information on the supported platforms and
software and hardware requirements, refer to “Hardware and Software Requirements” in the
Sun Java Enterprise System 5 Release Notes for Microsoft Windows.

If the operating system found on the host does not satisfy Java ES recommendations, the
installer cannot proceed. You must resolve this problem before installation.

Access Privileges
To install the Java ES software, you must be logged in as an administrator or as a user with
administrator privileges. A privileged user is a part of local administration group. Users in
nested groups are not considered privileged users. For example, a user from a group, which is a
part of the administration group, is not considered a privileged user.

Memory and Disk Space Requirements
To run the Java ES installer, you need 500 Mbyte of disk space in the Windows system drive and
1.5 Gbyte in the destination drive.

The installer runs a check to determine whether your host has sufficient memory and disk space
for the components you selected.

Determining Whether Your Hosts Are Ready
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■ If the memory found on the host does not satisfy the Java ES recommendations, the installer
displays a warning but allows the installation to proceed.

■ If the disk space found on the host is insufficient, the installer cannot proceed. You must
resolve this problem before you resume the installation.

You can solve this problem by mapping the %TEMP% to any other drive that contains required
amount of free space.

Verifying General Installation Prerequisites
The following table lists the tasks that you should perform before beginning any type of
installation. The left column lists the order in which you should perform the tasks and the right
column contains the location of instructions and other useful information. Not all tasks are
required for all installations.

TABLE 1–1 Preinstallation Checklist

Task Instructions and Helpful Information

1. Plan your Java ES installation. Refer to the Sun Java Enterprise System 5 Installation
Planning Guide.

2. Determine that a valid version of Java 2
Standard Edition (J2SETM) for Java ES is installed
on your machine.

If the installer does not find J2SE 1.5_09 or later on the
machine, the installer installs J2SE in the C:\Java
directory.

3. Determine whether any release noted issues
affect your installation.

Before performing any of the procedures described in the
Installation Guide, you should read the Sun Java
Enterprise System 5 Release Notes for Microsoft Windows.
These notes contain installation issues that might pertain
to your deployment.

4. Verify that system requirements are met. Refer to “Determining Whether Your Hosts Are Ready”
on page 22.

5. Determine whether an installation sequence
example can be used.

Refer to Chapter 2, “Example Installation Sequences.”

6. If you are installing Java ES components that
depend on servers or services that are already
installed, ensure that the existing servers and
services are accessible.

For example, if you are installing a Portal Server Secure
Remote Access subcomponent, the Secure Remote Access
core must be running and accessible.

7. Ensure that the drive you are using is an NTFS
drive.

To install Java ES on a Windows operating system, the
installation drive should be an NTFS drive.

Verifying General Installation Prerequisites
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TABLE 1–1 Preinstallation Checklist (Continued)
Task Instructions and Helpful Information

8. Stop firewall services. If there are any firewall running on your host system,
disable and stop firewall services and restart you host
system. Make sure that the firewall services are disabled
after restart.

Once the installation of Java ES 5 is complete, you can
restart these stopped firewall services.

Windows Distribution Bundles
The following table lists the distribution bundles for Java ES software:

TABLE 1–2 Windows Distribution Bundles

Distribution Bundle Contents Included Bundle Name

Windows platform All Java ES components
and shared components

Installer

Uninstaller

java_es-5-ga-windows-x86.zip

Windows Distribution Bundles
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TABLE 1–2 Windows Distribution Bundles (Continued)
Distribution Bundle Contents Included Bundle Name

Application Server Suite Access Manager

Application Server

Directory Server

HADB

Java DB

Message Queue

Portal Server

Portal Server Secure
Remote Access

Service Registry

Monitoring Console

Web Proxy Server

Web Server

All shared components

Installer

Uninstaller

java_es-5-appsuite-ga-windows-x86.zip

Access Manager Suite Access Manager

Application Server

Directory Server EE
(includes Directory
Server and Directory
Proxy Server)

HADB

Java DB

Message Queue

Monitoring Console

Web Server

All shared components

Installer

Uninstaller

java_es-5-identsuite-ga-windows-x86.zip
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TABLE 1–2 Windows Distribution Bundles (Continued)
Distribution Bundle Contents Included Bundle Name

Web Server Suite Access Manager

Application Server

Directory Server EE
(includes Directory
Server and Directory
Proxy Server)

HADB

Java DB

Message Queue

Monitoring Console

Service Registry

Web Proxy Server

Web Server

All shared components

Installer

Uninstaller

java_es-5-websuite-ga-windows-x86.zip

Obtaining the Java ES Software
You can obtain the Java ES software in the following ways:

■ As a web download
You can download Java ES software in several formats from the Sun Download Center at
http://www.sun.com/download. The following formats are available:
■ ISO DVD set image of all installation files for a single operating system
■ Compressed archive of all installation files for a single operating system
■ Compressed archive of all installation files for a suite

■ DVD
You can obtain a media kit that contains a DVD at
http://wwws.sun.com/software/javaenterprisesystem/index.html or by contacting
your Sun sales representative. Each DVD contains the installation files for a single operating
system, the Java ES installer program, and all the component packages. The DVD contains
the installation files for the operating systems, the Java ES installer program, and all the
component packages.

Obtaining the Java ES Software
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Example Installation Sequences

This chapter provides sequencing guidelines for some common Sun Java Enterprise System
(Java ES) installations.

This chapter contains the following sections:

■ “How to Use This Chapter” on page 27
■ “Single-Session Installation Examples” on page 28
■ “Access Manager SDK With Container Configuration Example” on page 37
■ “Identity Management Example” on page 39
■ “Web and Application Services Example” on page 41

How to Use This Chapter
The example installation sequences in this chapter provide high-level guidelines for some
common Java ES installations. These procedures provide the sequential steps required to
implement particular deployment scenarios.

The single-session examples describe typical steps for installing one or a number of Java ES
components on a single host in a single installation session. An evaluation example is included.
The remaining examples describe situations where multiple installation sessions are performed
on multiple hosts, for a variety of solutions. The sequences in this chapter are based on the
relationships among the Java ES components as shown in Sun Java Enterprise System 5
Installation Planning Guide.

At component selection, the Java ES installer identifies incompatible versions of components as
well as unmet requirements. Warning messages identify the problem and tell you what you
need to do. These message also tell you about incompatible versions of some or all of the
components that are already installed on the local host. You can also use the Java ES installer to
identify already installed components.

2C H A P T E R 2
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Tip – Remove or upgrade any incompatible versions of Java ES components before starting the
installer.

TABLE 2–1 Installation Sequence Guidelines

Installation Guideline Topic Description

Monitoring Monitoring Console cannot be run on the same host as Java ES
components that it monitors. Therefore, Monitoring Console should be
installed on another host in a separate installation session.

Installation-time configuration The following components can be installed in a Configure Automatically
During installation, but configuration cannot be performed during
installation: Monitoring Console and Service Registry.

Remote component If you are using a remote Java ES component to fulfill dependencies, the
remote Java ES component must be installed and running before
installing any Java ES components that depend on the remote
component.

Access Manager modes You must use Access Manager Legacy (6.x) installation type if you are
installing Access Manager with Portal Server. Access Manager Realm
(7.x) installation type can only be used if you are not installing Portal
Server.

Single-Session Installation Examples
The following examples apply to installation on a single host in a single session:
■ “Evaluation Example” on page 28
■ “Application Server Only Example” on page 30
■ “Directory Proxy Server Example” on page 31
■ “Directory Server-Only Example” on page 32
■ “Message Queue-Only Example” on page 33
■ “Monitoring Console-Only Example” on page 34
■ “Service Registry-Only Example” on page 35
■ “Web Server-Only Example” on page 36

Evaluation Example
An evaluation installation is generally considered a quick trial deployment. This example uses
the graphical interface, custom installation, and the Configure Automatically During
Installation type When you are presented with configuration pages, you accept defaults
wherever possible.

Single-Session Installation Examples
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This example installs all the Java ES components. Because Web Server is used as the web
container, Application Server is not installed.

▼ To Develop a Sequence for Java ES Evaluation

Check the installation sequence guidelines.

Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.

Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Start the Java ES graphical installer.

Choose the type of installation, select Custom.

The Java ES installer provides two types of installation:
Default Select and configures all products automatically with Web Server as the web

container

Custom Enables selection of Java ES components

Select the Configure Automatically During Installation type.
Messages indicate which Java ES components cannot be configured during installation.

At component selection, select Install All.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Verify installation directories.

Accept configuration defaults when they are offered.

View the Installation Summary and Log.

Complete postinstallation configuration.
Chapter 5, “Completing Postinstallation Configuration” contains instructions for
postinstallation configuration.

Start the Java ES components.
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Application Server Only Example
This example installs Application Server by itself.

▼ To Install Application Server: Example Sequence
Application Server requires a local copy of Message Queue. If you are using load balancing, a
local copy of a web server is required.

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Choose the type of installation, select Custom.

Select the Configure Automatically During Installation or Configure Manually After Installation
type.
For the Configure Automatically During Installation type, configuration pages are displayed for
the local Java ES components that can be configured during installation.

For the Configure Manually After Installation type, configuration pages are not displayed.

At component selection, choose Application Server.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Verify installation directories.

Run the installation.

View the Installation Summary and Log.

Complete postinstallation configuration.

Start Application Server which automatically starts Message Queue.
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Directory Proxy Server Example
This example installs Directory Proxy Server with Directory Server on a single host.

Note – Do not install Directory Proxy Server on the same system where Directory Server is
installed, except for evaluation.

▼ To Install Directory Proxy Server: Example Sequence

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Choose the type of installation, select Custom.

At component selection, select Directory Proxy Server.
If you are using a remote copy of Directory Server, deselect Directory Server and specify a
remote copy during postinstallation configuration.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Verify installation directories.

Run the installation.

View the Installation Summary and Log.

Complete postinstallation configuration.

Start the Directory Server first, then start the Directory Proxy Server.
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Directory Server-Only Example
This example installs Directory Server by itself.

▼ To Install Directory Server: Example Sequence
Directory Server has no dependencies on other Java ES components.

If your deployment calls for Schema 2, you must configure Directory Server for Schema 2 before
implementing any other Java ES components.

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Choose the type of installation, select Custom.

Select the Configure Automatically During Installation or Configure Manually After Installation
type.
For the Configure Automatically During Installation type, configuration pages are displayed for
the local Java ES components that can be configured during installation.

For the Configure Manually After Installation type, configuration pages are not displayed.

At component selection, select Directory Server.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Verify installation directories.

Run the installation.

View the Installation Summary and Log.

Complete postinstallation configuration.
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Start the Directory Server.

Message Queue-Only Example
This example installs Message Queue by itself. Message Queue has no dependencies on other
Java ES components.

▼ To Install Message Queue: Example Sequence

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Choose the type of installation, select Custom.

Select the Configure Manually After Installation type.

At component selection, select Message Queue.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Run the installation.

View the Installation Summary and Log.

Start Message Queue.
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Monitoring Console-Only Example
If your Java ES components use Java ES monitoring, you can install the Monitoring Console
component in addition to the other Java ES components. However, Monitoring Console cannot
run on the same host as any of the Java ES components. Monitoring Console must be installed
in a separate installation session.

▼ To Install Monitoring Console: Example Sequence

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.
Ensure that no other Java ES component products are installed on the same host as Monitoring
Console.

Choose the type of installation, select Custom.

Select the Configure Automatically During Installation or Configure Manually After Installation
type.

At component selection, choose Monitoring Console.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Verify installation directories.

Run the installation.

View the Installation Summary and Log.

Complete postinstallation configuration.
After installing all the components that will use monitoring on other hosts, you will need to
configure each of them for monitoring using instructions in Chapter 2, “Enabling and
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Configuring the Monitoring Framework,” in Sun Java Enterprise System 5 Monitoring Guide.
This document also contains instructions for administering and using Java ES monitoring.

Service Registry-Only Example
This example installs Service Registry by itself.

▼ To Install Service Registry: Example Sequence
Service Registry requires a local copy of Application Server, HADB, and at least two of its
subcomponents: Domain Administration Server and Command Line Administration Tool.
Message Queue is also required.

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Choose the type of installation, select Custom.

Select the Configure Automatically During Installation or Configure Manually After Installation
type.

At component selection, select Service Registry.
Application Server and its required subcomponents as well as HADB and Message Queue are
automatically selected.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Verify installation directories.

Run the installation.

View the Installation Summary and Log.
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Complete postinstallation configuration.

Start Service Registry.

Web Server-Only Example
This example installs Web Server by itself. Web Server has no dependencies on other Java ES
components.

▼ To Install Web Server: Example Sequence

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Choose the type of installation, select Custom.

Select the Configure Automatically During Installation or Configure Manually After Installation
type.

At component selection, select Web Server.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Verify installation directories.

Run the installation.

View the Installation Summary and Log.

Complete postinstallation configuration.

Start Web Server
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Access Manager SDK With Container Configuration Example
This example installs Access Manager SDK, using a copy of Access Manager that is already
installed on a remote host.

▼ To Configure Host A: Example Sequence
Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Accept licence agreement and select the destination folder for installation.

Choose the type of installation, select Custom.

Select the Configure Automatically During Installation or Configure Manually After Installation
type.
For post installation configuration information, see Chapter 5, “Completing Postinstallation
Configuration.”

At component selection, choose Access Manager, Directory Server, and web container.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Type administrator user name and password.

Run the installation.

View the Installation Summary and Log.

Verify that the Directory Server and web container are installed and running.
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Access the default Access Manager login page.
http://webserver-host:port/amserver

▼ To Configure Host B: Example Sequence
■ Access Manager core services must be installed and running on a remote host (Host A).
■ Web container information and Directory Server configuration information that you

provide in this installation example must match the web container and Directory Server
configuration information that you provided during installation of Access Manager core
services.

The Java ES installer does not allow you to configure the web container when you are installing
only the Access Manager SDK.

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Accept licence agreement and select the destination folder for installation.

Choose the type of installation, select Custom.

Select the Configure Manually After Installation type.

At component selection, choose Access Manager SDK.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Type administrator user name and password.

Run the installation.

View the Installation Summary and Log.
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Configure and start web container administration server.
For more information about configuring web container, see Chapter 5, “Completing
Postinstallation Configuration.”

Edit the AccessManager-base\setup\AMConfigurator.properties file.
Modify the following parameters in the AMConfigurator.properties file:

■ Set DEPLOY_LEVEL to 4.
■ Set SERVER_HOST and SERVER_PORT to the host and port of the full server which will be used

by Access Manager SDK.
■ Set DS_HOST, DS_DIRMGRPASSWD, and ROOT_SUFFIX to the hostname, directory manager

password, and root suffix of the Host A Directory Server.
■ Set ADMINPASSWD and AMLDAPUSERPASSWD to the amadmin and amldapuser passwords used

on Host A.
■ Set AM_ENC_PWD to the password encryption key used on Host A. For the Access Manager

SDK, use the same encryption key for AM_ENC_PWD as the encryption key specified during the
remote installation of Access Manager on Host B. Use the following command to obtain this
value: Accessmanager-base/config/AMConfig.properties

■ Set WEB_CONTAINER to the corresponding value for the web container being used.
■ Set BASEDIR to the install directory used during the Configure Manually After Installation of

Access Manager SDK.
■ Set AM_REALM to Enabled if realm mode is used on Host A, and Disabled if legacy mode is

used on Host A.
■ Find the settings corresponding to the web container that will be used for the SDK and

modify these settings with the details of the web container. For example, if WEB_CONTAINER is
set to WS6 (Sun Java System Web Server), then you should modify the settings that are
prefixed by WS61 (WS61_INSTANCE , WS61_HOME, WS61_PROTOCOL and so on.

As administrator, use the edited AMConfigurator.propertiesfile to deploy Access Manager.
AccessManager-base\setup\amconfig.bat

Identity Management Example
In this example, identity management is implemented by installing Access Manager and
Directory Server, with Directory Server on a remote host.
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▼ To Install Host A: Example Sequence
■ Access Manager requires Directory Server, but not necessarily a local copy.
■ Access Manager requires a web container, which in this example is Web Server.
■ Remote Directory Server must be running before installing any other Java ES components.

Installing and starting Directory Server
See “Directory Server-Only Example” on page 32.

▼ To Install Host B: Example Sequence
Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Accept licence agreement and select the destination folder for installation.

Choose the type of installation, select Custom.

Select the Configure Manually After Installation type.

At component selection, choose Access Manager and Web Server.
Directory Server is automatically selected and installed.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Type administrator user name and password.

Run the installation.

View the Installation Summary and Log.
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Edit the AccessManager-base\setup\AMConfigurator.properties file.
Set DS_HOST, DS_DIRMGRPASSWD, and ROOT_SUFFIX to the host name, directory
manager password , and root suffix of the Host A Directory Server.

Configure Web container and start the administration server.
For more information about configuring web container, see Chapter 5, “Completing
Postinstallation Configuration.”

Access the default Access Manager login page.
http://webserver-host:port/amserver

Web and Application Services Example
HADB, which is used for high availability session storage, works with Application Server to
provide failover capabilities that include session persistence.

This example provides guidelines for implementing a two-node HADB cluster with load
balancing. However, a preferred solution is to install HADB on four hosts with nothing else
installed on them. The domain administration server (DAS) with a copy of HADB for
administration and a load balancer and Web Server would be installed on a separate host.

On a partitioned operating system, a preferred solution is to install two host servers with at least
one HADB process running on each.

▼ To Install Web and Application Services: : Example
Sequence
The general tasks include:

■ Installing the Java ES components
■ Starting the servers
■ Configuring load balancing

The following example shows how to install all Java ES components on a node. On subsequent
nodes, install the Java ES components required by your deployment. A minimum of two
installation sessions are required.

■ Application Server requires a local copy of HADB and Message Queue.
■ Application Server and HADB must be on the same host so you can use the integrated

management tools provided by Application Server.
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■ Load Balancing Plug-in subcomponent of Application Server requires a Web Server. This
example uses the Sun Java System web container.

Check the installation sequence guidelines.
Check which guidelines apply to this example and make adjustments as needed. Refer to
Table 2–1.

Check the installation prerequisites.
Check which tasks you might need to perform for this installation before starting. Refer to
Table 1–1.

Run the Java ES installer.

Choose the type of installation, select Custom.

Select the Configure Automatically During Installation type.
Message Queue requires no configuration.

At component selection, choose Application Server.
Message Queue, HADB, and all the subcomponents of Application Server except the
Application Server Node Agent and Load Balancing Plug-in are automatically selected.

Expand the Application Server component and select Load Balancing Plug-in.

Note – You must install the Web Server and Load Balancing Plug-in using the same access
permissions.

Resolve incompatibilities.
The installer verifies software on your host and provides guidance if incompatibilities are
identified.

Run the installation.

View the Installation Summary and Log.

Start the Java ES components.

Complete load balancing configuration.
Refer to the Chapter 5, “Configuring HTTP Load Balancing,” in Sun Java System Application
Server Enterprise Edition 8.2 High Availability Administration Guide.

1

2

3

4

5

6

7

8

9

10

11

12

Web and Application Services Example

Sun Java Enterprise System 5 Installation Guide for Microsoft Windows • February 200742



Installing With the Graphical Interface

This chapter provides instructions for using the interactive graphical interface to install the Sun
Java Enterprise System (Java ES) software.

This chapter includes the following sections:

■ “Verifying Prerequisites” on page 43
■ “Running the Installer in Graphical Mode” on page 43
■ “To Cancel Installation” on page 50
■ “Next Steps” on page 50

Verifying Prerequisites
Refer to “Verifying General Installation Prerequisites” on page 23 for more specific
information.

You can find system requirements listed in “Hardware and Software Platform Information” in
Sun Java Enterprise System 5 Release Notes for Microsoft Windows

Running the Installer in Graphical Mode
If you have problems during installation, refer to the troubleshooting information in Chapter 8,
“Troubleshooting.”

▼ To Begin Installation
Access the DVD drive where the Sun Java Enterprise System is mounted.

Click the Setup launcher to start the wizard.
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Note – Run \setup.bat and NOT \Windows\setup.exe to start installation.

■ For a Download. Unzip the bits, navigate to the directory where you download the
software, and click the Setup Launcher (setup.bat).
■ For DVD. Navigate to a directory the DVD drive and click the Setup launcher.

The Welcome page is displayed.

Click Next to continue.

The Software License Agreement page is displayed.

Select I accept the terms of the license agreement. Click Next.

If J2SE Software Development Kit 5.0 update 9 or above is not detected in the system, the
following page enables you to specify a location to install the J2SE Software Development Kit
5.0 update 9:

Otherwise, the Choose Destination Location page is displayed:
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Browse to a folder where you want to install the Java ES.

To keep the default location, do not make any change. Click Next.

The Setup Type page is displayed:

Choose the type of installation from the following:

■ Default

Choose the Default type installation if you want to install and configure all the products and
features automatically at one instance.

■ Custom

Choose Custom type installation if you want to select the products and features to be
installed and configuration type.

▼ To Install by Default Setup Type
Select the Default setup type from the Setup Type page and Click Next.

All the components are installed and configured by Default and then the Administrator Settings
page appears

Click Next to continue.

The Administrator Settings page is displayed:
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Type the Administrative user ID, Administrative user password, and retype the Administrative
user password in the respective fields. Click Next.

Note – Though the values typed in this page are set as default values, you can modify these
default settings during the postinstallation.

The Start Copying Files page is displayed. This page also confirms the component selections for
this installation session.

The component selection page lists all the components to be installed and configured, click
Next.

To make any changes to component selection, click Back and make the appropriate changes.
The Setup Status page and subsequently the Installation In Progress page are displayed. The
Installation in Progress page is followed by the Configuration In Progress page. This display
might take some time depending on your server setup.

.

The Information page is displayed after the installation and configuration of the components
have been completed. Click Next to continue.

The Installation Complete page is displayed.

Click Finish to exit the setup.

▼ To Install by Custom Setup Type
Select the Custom set type from the Setup Type page. Click Next

The Product Configuration page is displayed as shown in the following example page:
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Choose the type of Configuration from the following:

■ “To Initiate the Configure Automatically During Installation” on page 47
■ “To Initiate the Configure Manually After Installation” on page 49

▼ To Initiate the Configure Automatically During
Installation
Configure automatically during installation installs the components you select and configures
them according to the default configuration settings. If you are new to Java ES and undecided
about the configuration best suited for your need, this option is good to start with.

Click Configure Automatically During Installation option then click Next.

The Customize Installation page is displayed:
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Choose the components that you want to install and configure automatically, by selecting and
deselecting the check boxes. You can select some or all components:

a. Select All Components. By default all the products are selected in the Product Selection
page.

b. Select Some Components. First deselect the check box next to Java ES, and then select the
check box next to the components you want to install. As you make each selection, the
installer automatically selects any other component that the component you selected
depends on.

Each selection causes additional files to be installed, adding to more disk space required for
installation. The page displays the disk space available on your host and the disk space
required by the components you selected.

c. Select Install multilingual package(s) for all selected components option to install language
packages.

When a web application is selected (Access Manager or Portal Server) and if no web container is
selected, the web container selection page appears.

Select one of the web containers and Click OK to return to the product selection page.

Click Next to continue.

The Administrator Settings page is displayed.

Type the Administrative user ID, Administrative user password, and retype the Administrative
user password in the respective fields. Click Next.

Note – Though the values typed in this page are set as default values, these default settings can be
modified during the postinstallation.

The Start Copying Files page is displayed. This page also confirms the component selections for
this installation session.

If the product selected lists all the components to be installed and configured, click Next. To
make any changes to the component selection, click Back and make the appropriate changes.

The Setup Status page and subsequently the Installation In Progress page are displayed. The
Installation in Progress page is followed by the Configuration In Progress page. This display
might take some time depending on your server setup.

The Information page is displayed after the installation and configuration of the components
have been completed.
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Click Next to continue.
The Installation Complete page is displayed.

Click Finish to exit the setup.

▼ To Initiate the Configure Manually After Installation
Configure Manually After Installation only installs the components you select. You need to
manually configure them later. See chapter on Chapter 5, “Completing Postinstallation
Configuration” to proceed with the configuration of the components after successful
installation.

Select the Configure manually after installation radio button. Click Next.
The Customize Installation page is displayed.

You must choose the components that you want to install by selecting and deselecting the
check boxes. You can select all or some of the components:

a. Select All Components. Select the check box next to Sun Java Enterprise System.

b. Select Some Components. Select the check box next to the components you want to install.
As you make each selection, the installer automatically selects any other components that
the component you selected depends on.

Note – You can choose to deselect installer selected components if you plan to use
components installed on remote systems.

Each selection causes additional files to be installed, adding to the disk space required for
installation. The page displays the disk space available on your host and the disk space
required by the components you selected.

c. Select Install multilingual package(s) for all selected components option to install language
packages.

Click Next to continue.
The Start Copying Files page is displayed. This page confirms the selections you made for
installation.

The Products Selected page lists all the components to be installed. Click Next. To make any
changes to component selection, click Back and make appropriate changes.
The Setup Status page and subsequently the Installation in Progress page are displayed. This
display might take some time depending on your server setup.
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The Information page is displayed after the installation has been completed.

Click Next to continue.

Note – Message Queue is automatically configured if selected. You do not need to configure
message queue separately.

The Installation Complete page is displayed.

Click Finish to exit the setup.
After an installation session, a summary file containing the list of products installed can viewed
from the installation wizard by clicking the View Summary button, or from the installation
directory where this file is saved.

To Cancel Installation
You can cancel the installation by clicking Cancel. Canceling starts the uninstallation process
and removes any Java ES software that is already installed.

If you selected the Configure Automatically During Installation option, you should not cancel
the installation after copying files for the installation is complete and the configuration is in
progress. Canceling the installation during configuration does not roll back the changes.

Next Steps
After you have completed the installation and configuration of components through the
Configure Automatically During Installation option, proceed to Chapter 6, “Verifying Installed
Java ES Components” to learn how to start and stop these components.

If you have completed the installation through the Configure Manually After Installation
option, proceed to the Chapter 5, “Completing Postinstallation Configuration” to learn how to
configure the components.
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Installing in Silent Mode

Silent installation is a noninteractive installation mode used for installing Sun Java Enterprise
System (Java ES) on multiple hosts that share similar configurations. This chapter provides
instructions for using the silent mode to install the Sun Java Enterprise System software.

The Windows installation wizard uses dialog boxes to receive the installation information.
However, a silent installation receives the installation information from the Install Shield Silent
Response file (.iss file).

A Response file contains information that is captured as responses to dialog boxes when
recording installation with the Windows installation wizard. During a silent installation, the
Setup.bat file reads the necessary input from the response file at runtime.

This chapter includes the following sections:

■ “Silent Installation Events” on page 51
■ “Creating a Response File” on page 52
■ “Running the Installer in Silent Mode” on page 55
■ “Next Steps” on page 56

Silent Installation Events
To run a silent installation, first record an installation session to create a Response file that the
silent installation process will use. In the response file, your responses are retained as a list of
parameters, each representing a single prompt or field. Using the response file as input, you can
then run the installer on many hosts. This process enables you to propagate one configuration
across multiple hosts in your enterprise.

To run an installation silently based on the contents of a response file, run the Setup.bat with
the /s argument. By default, Setup.bat looks for a response file called Setup.iss in the same
directory as Setup.bat. You can use /f1 argument to specify an alternative name and location
of the response file.
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A silent installation program does not display a dialog box if an error occurs. The status
information is recorded in the Setup.log file. By default, the log file is created in the same
directory from where the response file is being used. You can specify a different name and
location for the log file by using the /f2 argument to the Setup.bat command.

▼ To Perform a Silent Installation
Develop your installation plan.

Survey your system for incompatibilities. For more information, see “Verifying General
Installation Prerequisites” on page 23.

Run the installer to generate a response file for you.

For more information, see “Creating a Response File” on page 52.

Make a copy of the response file before editing.

Edit the response file values for the target systems.

For more information, see “Editing the Response File” on page 53.

Run the installer specifying the response file.

For more information, see “Running the Installer in Silent Mode” on page 55.

Creating a Response File
To create a response file, first run the installer for a record installation. A response file generated
by the installer takes advantage of the installer’s real-time dependency checking and error
reporting.

The format of response files resembles that of an .ini file, but response files have the .iss
extension. A response file is a plain text file that consists of sections containing data entries. By
default, the response file is called Setup.iss and is created in the Windows System directory.

Caution – If you are an experienced user of the installer, you might be accustomed to building
response files manually. However, this method can cause problems at installation time,
configuration time, or server startup time.
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▼ To Generate a Response File Using the Installer
At the command prompt, navigate to the directory where the installer is located.
cd JavaES-install-dir

Use the Setup.bat /r command to create the response file, either in the default location or in
the system's Windows folder or in a location you specify.
Use the /f1 option to specify where the response file is to be created and to provide a name. To
avoid unpredictable results. specify an absolute path for the file that has the .iss extension. For
example, type:

Setup.bat /r /f1"C:\Temp\example.iss".

Note – Run \Setup.bat and not \Windows\setup.exe to start the installation.

Proceed with the installation providing the information that you want the silent installer to
provide.
All the data typed and options selected are recorded in the .iss file.

At the end of the installation, the response file is generated.

The response file is ready for use with the options selected during the record installation. The
response file can be edited manually to modify the options recorded. For information about
how to edit a response file, see “Editing the Response File” on page 53.

Editing the Response File
After you have generated a response file, you can edit the response file to modify local
parameters. These parameters include Administrator User ID, Administrator Password and
Retype Password.

When editing the response file, follow these guidelines:

■ Do not modify parameters except to edit their values.
■ Do not remove a parameter even if the parameter does not have a value.
■ Do not add a parameter.
■ Do not change the order in which parameters appear.
■ Notice original types and formats and maintain them as you type new values.
■ Replace any value that you delete. If the parameter is required, installation or configuration

could fail if the parameter has been deleted.

1

2

3

4

See Also

Creating a Response File

Chapter 4 • Installing in Silent Mode 53



■ To add a component, change both the SunJavaES-count= (total) and SunJavaES-(count
number)=SunJavaES\.... For example,
Original:

SunJavaES-count=2

SunJavaES-0=SunJavaES\MessageQueue

SunJavaES-1=SunJavaES\DirectoryServer

Modified:

SunJavaES-count=3

SunJavaES-0=SunJavaES\MessageQueue

SunJavaES-1=SunJavaES\DirectoryServer

SunJavaES-2=SunJavaES\WebServer

For more information on response file, see Appendix C, “Example Response File: Silent
Installation”

■ To add a subcomponent, change both total count and count number. The subcomponent is
added after the main component. For example:

SunJavaES-3=SunJavaES\AccessManager\AMAdministrationConsole

■ The response file contains sections corresponding to the SdWelcome dialog box. For
example:

[{311E6252-893E-4445-B865-94DAFF5C500C}-SdWelcome-0]

Result=1

The section header [{311E6252-893E-4445-B865-94DAFF5C500C}-SdWelcome-0] indicates
that the data pertains to the SdWelcome dialog box for a component with ProductCode
(and PRODUCT_GUID) value {311E6252-893E-4445-B865-94DAFF5C500C }.

The -0 at the end of the header indicates that this is the first call to SdWelcome. If the
installation displayed a second SdWelcome dialog box, its header would end with -1.

The Result=1 indicates the return value from the SdWelcome function. The return value 1
indicates that you clicked the Next button.

■ In the SdSetupType dialog box, the Quick_Configure specifies Configure Automatically
During Installation and Configure_Later specifies Configure Manually After Installation.
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Running the Installer in Silent Mode
Running an installation silently requires a previously recorded response file. For more
information, see “Creating a Response File” on page 52. Run the installer on a host that has the
same operating system as the host on which you generated the response file.

▼ To Run the Installer in Silent Mode
At the command prompt, navigate to the directory where the installer is located.
cd JavaES-install-dir

Use the Setup.bat /s command to initiate a silent mode installation process.

Note – By default the Setup.iss file is created in Windows System folder. You need to copy this
file from the Windows System to the folder where the Setup.bat exists before starting silent
installation as Setup.bat /s. Otherwise, the command returns -3 error in setup.

Use the /f1 option to specify the .iss file location. To avoid unpredictable results, specify an
absolute path. For example, type:

Setup.bat /s /f1"C:\Temp\example.iss".

(Optional) Use the Setup.bat /s with /f2 option to specify an alternative location and file
name for the log file. To avoid unpredictable results, specify an absolute path for the file. For
example, type:
Setup.bat /s /f1"C:\Temp\UninstallExample.iss /f2"C:\Setup.log".

Silent installation can be lengthy, depending on the number and type of components that you
are installing. While the installer is running, you can monitor its progress by examining
changes to the installation log.

Understanding the Setup.log File
Setup.log is the default name for the silent installation log file generated when you run the
Setup.bat command with the /s argument. The Setup.log file contains the following three
sections:

■ Install Shield Silent: This section identifies the file as a log file and provides the version of
Install Shield Silent used in the silent setup.

■ Application: This section identifies the name and version of the installed application, as well
as the company name.
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■ Response Result: This section contains the result code indicating whether the silent setup
succeeded. An integer value is assigned to the ResultCode key name in the Response Result
section.

Install Shield places one of the following return values in the ResultCode key:

ResultCode ResultCode Description

0 Success

-1 General error

-2 Invalid mode

-3 Required data not found in the Setup.iss file

-4 Not enough memory available

-5 File does not exist

-6 Cannot write to the response file

-7 Unable to write to the log file

-8 Invalid path to the Install Shield Silent response (.iss) file

-9 Not a valid list type (string or number)

-10 Data type is invalid

-11 Unknown error during setup

-12 Dialog boxes are out of order

-51 Cannot create the specified folder

-52 Cannot access the specified file or folder

-53 Invalid option selected

The log file for a successful silent installation appears as follows:

[ResponseResult]

ResultCode=0

Next Steps
After you complete the silent installation, proceed to Chapter 5, “Completing Postinstallation
Configuration” for information about configuring your components. Even if performed
extensive configuration during your installation, most components require some additional
configuration.
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Note – Review the postinstallation configuration requirements carefully before proceeding to
any other tasks.
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Completing Postinstallation Configuration

This chapter contains instructions for completing initial configuration of the Sun Java
Enterprise System (Java ES) components after installation. If a Java ES component is not listed
in this chapter, postinstallation configuration is not required for that component. However,
that component might still require postinstallation tasks related monitoring data service if you
are installing these Java ES components.

This chapter contains the following sections:

■ “How to Use This Chapter” on page 59
■ “Monitoring Console Postinstallation Configuration” on page 60
■ “Access Manager Postinstallation Configuration” on page 60
■ “Application Server Postinstallation Configuration” on page 62
■ “Directory Proxy Server Postinstallation Configuration Operation” on page 64
■ “Directory Server Postinstallation Configuration” on page 64
■ “HADB Postinstallation Configuration” on page 65
■ “Message Queue Postinstallation Configuration” on page 65
■ “Service Registry Postinstallation Configuration” on page 65
■ “Web Proxy Server Postinstallation Configuration” on page 66
■ “Web Server Postinstallation Configuration” on page 67
■ “Configuring the Java Virtual Machine Software” on page 67
■ “Next Steps” on page 68

How to Use This Chapter
When the Java ES installer finishes installation, most components require additional
configuration before the Java ES environment is operational. The extent of this work depends
on the configuration type you selected, either Configure Automatically During Installation or
Configure Manually After Installation.

If you selected the Configure Manually After Installation option, the installer placed the
component package files in their respective directories. No parameters were set, and most
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components are not operational because runtime services are not available. A number of
components include configuration tools for completing a manual configuration after
installation. When running the configuration tools, you can make any additional changes by
following the instructions located in this guide, and in the documentation for each component.

Before acting on the information in this chapter, you should have completed the installation of
the Java ES components. For a list of packages associated with the components, see Appendix B,
“Default Directories and Ports.” A summary report containing the configuration values that
were set during installation is available in the JavaES-install-dir\Summarydate.txt file.

After completing installation, review the procedures included in this chapter for the Java ES
components that you installed. If no additional configuration is required for your Java ES
components, you can start your Java ES components by following the instructions in Chapter 6,
“Verifying Installed Java ES Components.”

Note – The default installation locations of Java ES components might be different on the various
platforms. Therefore, the procedures in this chapter use variables to represent these locations.
For example, ApplicationServer-base represents the directory where Application Server is
installed, regardless of platform.

Monitoring Console Postinstallation Configuration
If the Java ES components you have installed will use Java ES monitoring, you must configure
each component to use the monitoring framework. For configuration instructions, refer to
Chapter 2, “Enabling and Configuring the Monitoring Framework,” in Sun Java Enterprise
System 5 Monitoring Guide.

Access Manager Postinstallation Configuration
Whenever you use the Java ES installer to configure Access Manager on Web Server, you will
need to perform the following steps.

Note – For all Access Manager installations, the web container needs to be restarted. If a full
installation is being performed on Web Server or Application Server, the installer stops the web
container instance, which requires you to start web container manually. For instructions on
restarting Access Manager, see “Starting and Stopping Access Manager” on page 70.

Monitoring Console Postinstallation Configuration
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▼ To Configure Access Manager on Web Server
Start the Directory Server.

Start the web container.

Configuring Access Manager After a Configure
Automatically During Installation
After a Configure Automatically During Installation, you can start Access Manager and log in to
the Access Manager console. However, you cannot perform basic user management operations
until you complete some final configuration steps. These steps differ depending on whether
Access Manager is using a Directory Server instance that is already provisioned with user data.
There are additional configuration tasks that you might want to perform for your deployment.

■ Directory Server Provisioning Situations
■ Enabling the Directory Server Referential Integrity Plug-in
■ Adding Access Manager Indexes to Directory Server

For instructions on performing these tasks, refer to the Sun Java System Access Manager 7.1
Postinstallation Guide.

Configuring Access Manager After a Configure
Manually After Installation Operation
After a Configure manually after installation operation, the packages are installed and you are
ready to configure Access Manager by using the Access Manager configuration batch file,
AccessManager-base\setup\amconfig.bat. For more information about using this program,
see Sun Java System Access Manager 7.1 Postinstallation Guide.

For instructions on configuring Access Manager for a third-party web container (BEA
WebLogic or IBM WebSphere Application Server), see Sun Java System Access Manager 7.1
Postinstallation Guide.
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Application Server Postinstallation Configuration
After a Configure automatically during installation operation, Application Server requires no
postinstallation configuration but you need to configure Application Server load balancing
plug-in after Configure automatically during installation and Configure manually after
installation operations.

▼ To Configure Application Server After a Configure
Manually After Installation Operation
Locate the accessory DVD for Application Server.
Accessory contents can also be downloaded from the Sun Download Center at
http://www.sun.com/download/index.jsp.

Refer to the README file in the Addon folder on the DVD and follow the procedures detailed
there.

Modify the ApplicationServer-base\samples\common.properties file.
Modify the following properties in the common.properties file. If you do not know the paths
for some properties, you can copy them from the ApplicationServer-base \config\asenv.conf
file.
■ com.sun.aas.derbyRoot=JavaDB-base

■ com.sun.aas.webServicesLib=ApplicationServer-base/lib

■ com.sun.aas.imqHome=ApplicationServer-base/domains/domain1/imq

■ com.sun.aas.imqBinDir=MessageQueue-base/bin

■ com.sun.aas.imqUserMgr=MessageQueue-base/bin/imqusermgr

■ com.sun.aas.imqLib=MessageQueue-base/lib

■ com.sun.aas.installRoot=ApplicationServer-base

■ com.sun.aas.javaRoot=J2SE-base

■ com.sun.aas.domains.dir=ApplicationServer-base/domains

■ #admin.password=

The admin password is not saved as the default. You can type the password and save it
manually.

■ admin.host=jws-v210-4

■ appserver.instance=server

By default the value of appserver.instance is AppServer1. Replace AppServer1 with
server. For more information, see bug id 6485254.
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■ appserver.instance.port=8080

■ admin.user=admin

■ admin.port=4849

■ derby.port=1527

■ domain.name=domain1

■ server.cert.alias=s1as

■ keystore=${com.sun.aas.domains.dir}/${domain.name}/config/keystore.jks

■ keystore.password=changeit

■ trustStore=${com.sun.aas.domains.dir}/${domain.name}/config/cacerts.jks

Note – To configure Application Server for load balancing, refer to the “Configuring Web
Servers for HTTP Load Balancing” section in the Chapter 5, “Configuring HTTP Load
Balancing,” in Sun Java System Application Server Enterprise Edition 8.2 High Availability
Administration Guide.

▼ To Configure Application Server Load Balancing
Plug-in

Set value of IS_LB to true and Cfgr_LB to false in the registry.
Windows 2000 HKEY_LOCAL_MACHINE > Software > Sun Microsystems >

EntSys5 > Installer > Application Server

Windows 2003 x64 edition HKEY_LOCAL_MACHINE > Software > Wow6432node > Sun
Microsystems > EntSys5 > Installer > Application Server

Edit the ApplicationServer-base\setup\ASConfigurator.properties file.
Set the value for AS_WSINSTANCEDIR and AS_WSINSTANCENAME properties. For example, type:

AS_WSINSTANCEDIR=C:\\Sun\\JavaES5\\WebServer7\\https-jws-winpc-1.red.iplanet.com

AS_WSINSTANCENAME=https-jws-winpc-1.red.iplanet.com

Run the ApplicationServer-base\setup\ASConfigure.bat command.
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Directory Proxy Server Postinstallation Configuration
Operation

After a Configure automatically during installation operation, no additional configuration is
necessary.

After a Configure manually after installation operation, the packages are installed and you are
ready to configure Directory Proxy Server. Instructions for Directory Proxy Server Instance
Creation can be found in the Sun Java System Directory Server Enterprise Edition 6.0 Installation
Guide.

▼ To Configure a Directory Proxy Server After a
Configure Manually After Installation Operation

Change to the DirectoryProxyServer-base\dps6\bindirectory.
cd DirectoryProxyServer-base\dps6\bin

Create a Directory Proxy Server instance.
dpadm.exe create -p port-no -P ssl-port-no instance-path

Start the instance.
dpadm.exe start instance-path

Directory Server Postinstallation Configuration
After a Configure manually after installation operation, the packages are installed and you are
ready to perform the configuration tasks for Directory Server.

▼ To Configure Directory Server After a Configure
Manually After Installation Operation

Change to the DirectoryServer-base\ds6\bindirectory.
cd DirectoryServer-base\ds6\bin

Create a Directory Server instance.
dsadm.exe create -p port-no -P ssl-port-no instance-path
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Start the instance.
dsadm.exe start instance-path

Create a root suffix with corresponding domain components.
dsconf.exe create-suffix --unsecured -p port-no root-suffix

▼ To Configure Directory Service Control Center (DSCC)
After a Configure Manually After Installation
Operation

Change to the DirectoryServer-base\ds6\bindirectory.
cd DirectoryServer-base\ds6\bin

Run dsccsetup.exe.

HADB Postinstallation Configuration
HADB does not require any additional postinstallation configuration.

Message Queue Postinstallation Configuration
After a Configure automatically during installation operation, no additional configuration is
required. You can start the Message Queue using Windows services, see “To Start the Message
Queue Using Windows Services” on page 74.

After a configure manually after installation operation, the packages are installed and you are
ready to perform the configuration tasks for Message Queue. For more information about
postinstallation configuration instructions, see the Sun Java System Message Queue 3.7 UR1
Administration Guide

Service Registry Postinstallation Configuration
Service Registry cannot be configured automatically during installation. After a Configure
manually after installation operation, the packages are installed and you are ready to perform
the configuration tasks for Service Registry by using the following procedure.
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▼ To Configure the Service Registry After a Configure
Manually After Installation Using Default Properties
The configuration process creates an Application Server domain at ServiceRegistry-base\data.
The default domain name is registry. The configuration process then starts the domain, deploys
Service Registry, and leaves the domain running. The default configuration directory is
ServiceRegisry-base.

Log in as administrator.

Change to the ServiceRegistry-base\installdirectory.

Verify that the JAVA_HOME environment variable is set.

Run the SRConfig.bat command.

Note – To perform configuration by using custom property settings, see the Service Registry 3.1
Administration Guide.

Web Proxy Server Postinstallation Configuration
After a Configure automatically during installation operation, no additional configuration is
needed. After a Configure manually after installation operation, the packages are installed and
you are ready to configure Web Proxy Server by using the following procedure.

▼ To Configure Web Proxy Server After a Configure
Manually After Installation Operation

Change to the Web Proxy Server-base \bin\proxy\install\miscdirectory.

Update the property file with your settings.
For example, the wps.properties file might contain the following:
WPS_JDK_HOME=<Java_Home>

WPS_SERVER_ROOT=JavaES-install-dir\webproxyserver

WPS_ADMIN_NAME=admin

WPS_ADMIN_PWD=admin123

WPS_ADMIN_PORT=8889

WPS_START_ON_BOOT=N

WPS_ADMIN_SERVER_USER=root
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WPS_SERVER_NAME=jws-v60x-4.red.iplanet.com

WPS_SERVER_PORT=8081

WPS_SERVER_ID=proxy-server1

WPS_ADMIN_SERVER_ID=proxy-admserv

WPS_SERVER_USER=root

Go to the location WebProxyServer-base.

Run the WPSConfigure.bat command.

Web Server Postinstallation Configuration
After a Configure automatically during installation operation, no additional configuration is
required for Web Server configuration.

▼ To Configure Web Server After a Configure Manually
After Installation Operation
After a Configure manually after installation operation, the packages are installed and you are
ready to configure Web Server by using the following procedure.

Create a runtime configuration for Web Server by running the Web Server configurator.
For more information, see the “Configure Later Mode (Java ES Only)” in Sun Java System Web
Server 7.0 Installation and Migration Guide.

Verify the common server settings and update settings as needed.

Configuring the Java Virtual Machine Software
After you have finished the required postinstallation configuration for your Java ES
components, some Java ES components might require that you tune the Java Virtual Machine
(JVMTM) software. The JVM software consists of several entities, the most significant being the
compiler, which turns Java byte code into machine instructions. In the version of the Java
development kit (JDKTM) software that is included with this Java ES release, several choices can
be made for the JVM software. The best starting option is the –server option. The –server
option is a good tuning option for a JVM running in server mode. You can obtain the list of
options by using the java –? command.

Another significant tuning option that might need to be configured is the Java heap memory.
For example:
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■ To set the initial Java heap size, use -Xmssize.
■ To set the maximum Java heap size, use -Xmxsize.

A good starting point for a heavily used system would be to set the maximum heap size to 1.2
Gbytes.

Next Steps
After you have completed the configuration tasks in this chapter, verify postinstallation
configuration by starting the Java ES components as described in Chapter 6, “Verifying
Installed Java ES Components.”
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Verifying Installed Java ES Components

This chapter provides instructions for starting and stopping Sun Java Enterprise System (Java
ES) components that have been installed and configured. You can use the procedures in this
section to verify that the components are operational.

Before using the procedures in this chapter, you should have completed all the postinstallation
configuration tasks specified in Chapter 5, “Completing Postinstallation Configuration.”

Note – If you used the Configure automatically during installation option, see the summary.txt
file in the installation root location for information regarding each component.

This chapter includes the following sections:

■ “Startup Sequence for Java ES” on page 70
■ “Starting and Stopping Access Manager” on page 70
■ “Starting and Stopping Application Server” on page 70
■ “Starting and Stopping Directory Server” on page 72
■ “Starting and Stopping Directory Proxy Server” on page 72
■ “Starting and Stopping the HADB Management Agent” on page 73
■ “Starting and Stopping Message Queue” on page 74
■ “Starting and Stopping Monitoring Console” on page 75
■ “Starting the Web Container to Access the Portal Server Desktop” on page 75
■ “Starting and Stopping Portal Server” on page 76
■ “Starting and Stopping the Service Registry” on page 77
■ “Starting and Stopping Web Proxy Server” on page 78
■ “Starting and Stopping Web Server” on page 80
■ “Next Steps” on page 83
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Startup Sequence for Java ES
The startup sequence for Java ES 5 depends on the web container. If Web Server is the web
container then the startup sequence is:

1. Common Agent Container
2. Directory Server
3. Web Server

If Application Server is the web container then the startup sequence is:

1. Common Agent Container
2. Directory Server
3. HADB
4. Message Queue
5. Application Server

Portal Server and Access Manager run inside the web container, you access them only when you
start the web container.

Starting and Stopping Access Manager
Access Manager depends on Directory Server and a web container to function as expected.
Access Manager can be deployed into the following web containers:

■ Web Server
■ Application Server

By default, the web containers are not running after installation. You need to start the web
container. For more information on starting and stopping the Web Server and Application
Server, see “Starting and Stopping Web Server” on page 80 and “Starting and Stopping
Application Server” on page 70 respectively. Directory Server must also be running for Access
Manager to function. For more information about starting theDirectory Server, see “Starting
and Stopping Directory Server” on page 72.

Access Manager does not include any start or stop entries in the Services page.

Starting and Stopping Application Server
Application Server depends on Message Queue to function. If you have selected the start servers
option in the Finish page of Java ES installer, the Application Server is started automatically
after installation.

You can also start and stop the Application Server by accessing the .bat file in the bin folder of
the Application Server installation directory.

Startup Sequence for Java ES
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▼ To Start an Application Server Domain
Change to the ApplicationServer-base\bindirectory.

Start the Application Server Domain.
asadmin.bat start-domain --user admin-user-ID --passwordfile passwordFileName
domain-name

For example, type the following command to start domain1 with admin-user-ID admin and
passwordFileName passfile:

asadmin.bat start-domain --user admin --passwordfile passfile domain1

▼ To Stop an Application Server Domain
Change to the ApplicationServer-base\bindirectory.

Stop the Application Server Domain:
asadmin.bat stop-domain domainName

▼ To Start an Application Server Agent
Change to the ApplicationServer-base\bindirectory.

Start the Application Server Agent:
asadmin.bat start-node-agent --port admin-Port --user admin-user-ID --password

admin-password node-agent--name

▼ To Stop an Application Server Agent
Change to the ApplicationServer-base\bindirectory.

Start the Application Server Agent:
asadmin.bat stop-node-agent node-agent-name
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Starting and Stopping Directory Server
By default, the Directory Serveris started when you complete your installation.

You can also start and stop the Directory Server by accessing the dsadm.exe file in the bin
folder of the Directory Server installation directory.

▼ To Start the Directory Server
Change to the DirectoryServer-base\ds6\bindirectory.
cd DirectoryServer-base\ds6\bin

Start the Directory Server instance.
dsadm.exe start instance-path

For example, type the following command to start the Directory Server instance.

dsadm.exe start C:\Program Files\Sun\JavaES5\DSEE\var\DSInstance

▼ To Stop the Directory Server
Change to the DirectoryServer-base\ds6\bindirectory.
cd DirectoryServer-base\ds6\bin

Stop the Directory Server instance.
dsadm.exe stop instance-path

Starting and Stopping Directory Proxy Server
By default, the Directory Proxy Server is started when you complete your installation.

You can also start and stop the Directory Proxy Server by accessing the dsadm.exe file in the
Directory Proxy Server folder of the Directory Proxy Server installation directory.

▼ To Start the Directory Proxy Server
Change to the DirectoryServer-base\dps6\bindirectory.
cd DirectoryServer-base\dps6\bin
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Start the Directory Proxy Server instance.

dpadm.exe start instance-path

For example, type the following command to start the Directory Proxy Server instance.

dpadm.exe start C:\Program Files\Sun\JavaES5\DSEE\var\DPSInstance

▼ To Stop the Directory Proxy Server
Change to the DirectoryServer-base\dps6\bindirectory.

cd DirectoryServer-base\dps6\bin

Stop the Directory Proxy Server instance.

dpadm.exe stop instance-path

Starting and Stopping the HADB Management Agent
the HADB management agent is registered as Windows Server. The HABD service starts
automatically as the start type

After a successful Java ES installation, the HADBMgmtAgent service is registered as Windows
services. This services starts automatically because the start up type for HADB is set as
Automatic. Follow the next procedure to stop the HADB management agent.

▼ To Stop HADB From Services
Choose Start > Settings > Control Panel.

Select Administrative Tools.

Select Services.

Select the HADBMgmtAgent service you want to stop from the Services list.

You can use one of the following methods to stop the service:

■ Click mouse button 2 and select Stop.
■ Click the Stop service icon.
■ Select Stop from the Action Menu.
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Starting and Stopping Message Queue
Message Queue has no dependencies. By default, the Java ES installer installs Message Queue
for automatic startup on Windows. At times, you might want to start or stop the Message
Queue service on Windows.

▼ To Start the Message Queue From the Windows Start
Menu

Choose Start > Programs > Sun Java Enterprise System 5 > Message Queue 3.7 UR1> Message
Broker.

▼ To Start the Message Queue Using Windows Services
Choose Start > Settings > Control Panel.

Select Administrative Tools.

Select Services.

Select Message Queue Broker from the Services list.
You can use one of the following methods to start the service:

■ Click mouse button 2 and select Start.
■ Click the Start Service icon.
■ Select Start from the Action Menu.

▼ To Stop the Message Queue Using Windows Services
Choose Start > Settings > Control Panel.

Select Administrative Tools.

Select Services.

Select Message Queue Broker from the Services list.
You can use one of the following methods to stop the service:

■ Click mouse button 2 and select Stop.
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■ Click the Stop Service icon.
■ Select Stop from the Action Menu.

Starting and Stopping Monitoring Console
Monitoring Console cannot be run from the same host where any of the Java ES components
are installed. For information about how to use Monitoring Console, see the “Starting the
Monitoring Console” in Sun Java Enterprise System 5 Monitoring Guide.

Starting the Web Container to Access the Portal Server
Desktop

The Portal Server startup and shutdown mechanisms are part of the startup and shutdown
mechanisms for the web container on which the Sun Java Systems web container runs. Portal
Server also depends on Directory Server, Access Manager, and the Access Manager SDK. The
following sections describe how to start your Sun web container, Access Manager, and Portal
Server after installation and configuration:

■ “Starting and Stopping Application Server” on page 70

Portal Server administration is managed by using the Access Manager Administration Console.
See “Starting and Stopping Access Manager” on page 70 for information about how to open the
Access Manager Administration Console.

▼ To Access the Portal Server Desktop From a Sun Web
Container
The web protocol for Portal Server can be either HTTP or HTTPS. By default, the host is
hostname.domain.

In a browser window, use the following URL format to display the sample Desktop.
The default Portal Access URL and default deployment URI are /portal.
http://hostname.domain:port/portal

When you enter the URL, the welcome page is displayed, including a short description of Portal
Server and links to sample portals that you selected for installation. Click one of the links to
access the anonymous portal desktop for the sample portal. If the sample desktop displays
without any exception, your Portal Server installation was successful.

Type the following in the browser URL field:
http://hostname.domain:port/psconsole

1

2

Starting the Web Container to Access the Portal Server Desktop

Chapter 6 • Verifying Installed Java ES Components 75



Verify that the gateway is running on the specified port.
netstat -a

The default port is 443.

■ If the gateway is not running, start the gateway.
C:\Sun\JavaES5\portal\bin\gateway.bat

View the log files to verify that no problems have been logged.

Run Portal Server in secure mode by typing the following in the browser URL field:
https://gateway-hostname:port

If you have chosen the default port (443) during installation, you do not need to specify the port
number.

Starting and Stopping Portal Server
The Portal Serverstartup and shutdown mechanisms are part of the startup and shutdown
mechanisms for the web container, either Web Server or an application server. Portal Server
depends on Directory Server, Access Manager or Access Manager SDK, and a web container.

▼ To Start the Portal Server
Start the Directory Server instance.
JavaES5-Install-Dir\DSEE\ds6\bin\dsadm.exe start DSInstancePath

Start the Cacao Server instance.
JavaES5-Install-Dir\share\cacao_2\bin\cacaoadm.bat start

Wait for some time to ensure that the Cacao Server is started.

(Optional) Verify the Cacao Server status.
JavaES5-Install-Dir\share\cacao_2\bin\cacaoadm.bat status

Cacao Server status is displayed in the following format:
default instance is DISABLED at system startup.

Current retries count : 0/4

Processes:

3780

Uptime: 0 day(s), 0:8

3

4

5

1

2

3

Starting and Stopping Portal Server

Sun Java Enterprise System 5 Installation Guide for Microsoft Windows • February 200776



Start the Derby Server instance.
JavaES5-Install-Dir\share\ant\bin\ant.bat -buildfile PortalServer-base\lib\derby.xml
-propertyfile PortalServer-base\config\PSConfig.properties start-instance

Note – If the Derby Server is not started then the Wiki and community samples will fail.

Start the web container, which can be Web Server or Application Server.

Note – If both Access Manager and Portal Server are deployed on the same web container,
starting web container brings up both Access Manager and Portal Server by default.

a. To Start the Application Server, type:
JavaES5-Install-Dir\appserver\bin\asadmin.bat start-domain --user

adminUserName --password adminPassword deployedDomain

Starting and Stopping the Service Registry
Service Registry installation creates an Application Server domain in
ServiceRegistry-basedata\domains\registry directory.

The Application Server administrative console for this domain has port number 6489. Service
Registry is automatically deployed as a web application in the registry domain at port 6480.

▼ To Start Service Registry
Change to the ServiceRegistry-base directory.

Start Service Registry.
JavaES-install-dir\share\ant\bin\ant.bat -f build-install.xml

appserver.domain.start

A message is displayed telling you that the server is starting. When the startup process has been
completed, an additional message is displayed.

▼ To Access the Service Registry Web Console
To access theService Registry Web Console, use the following URL format in your browser:
https://hostname:port
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Specify your local host as hostname if you are running your browser on the same system where
Service Registry is installed.
Otherwise, instead of specifying your local host as hostname, use the name of the system that
Service Registry is running on.

The default port number assigned during installation is 6480. For example:
https://mycomputer.example.com:6480

You should see the Web Console welcome page. The default login name is admin. The password
is set during installation.

Expand the Applications node, then the Web Applications node. Service Registry is deployed as
a web application named soar.

▼ To Stop Service Registry
Change to the ServiceRegistry-base directory.

Stop Service Registry.
JavaES-install-dir\share\ant\bin\ant.bat -f build-install.xml

appserver.domain.stop

▼ To Restart Service Registry
Change to the ServiceRegistry-base\install directory.

Restart Service Registry.
JavaES-install-dir\share\ant\bin\ant.bat build-install.xml appserver.domain.bounce

Starting and Stopping Web Proxy Server

▼ To Start the Proxy Administration Server Service From
the Command Prompt

Change to the WebProxyServer-base\admin-service-id\directory.

Type startsvr.bat.
The default admin-service ID is proxy-admserv.
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▼ To Stop the Proxy Admin Server Service From the
Command Prompt

Change to the WebProxyServer-base\admin-service-id\directory.

Type stopsvr.bat.

The default admin-service ID is proxy-admserv.

▼ To Start the Proxy Server Service From the Command
Prompt

Change to the WebProxyServer-base\proxy-service-id\directory.

Type startsvr.bat.

The default proxy-service ID is proxy-server1.

▼ To Stop the Proxy Server Service From the Command
Prompt

Change to the WebProxyServer-base\proxy-service-id\directory.

Type stopsvr.bat.

The default proxy-service ID is proxy-server1.

▼ To Start the Socks Server Service From the Command
Prompt

Change to the JavaES-install-dir\proxy-service-id\directory.

Type startsockd.bat.

The default proxy-service ID is proxy-server1.
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▼ To Stop the Socks Server Service From the Command
Prompt

Change to the JavaES-install-dir\proxy-service-id\directory.

Type stopsockd.bat.
The default proxy-service ID is proxy-server1.

▼ To Start the Proxy Admin Server Service From the
Start Menu

Choose Start>Programs>Sun Java Enterprise System 5>Web Proxy Server 4.0.4>Start Admin
Server.

▼ To Start Proxy Server Service From the Start Menu
Choose Start>Programs> Sun Java Enterprise System 5>Web Proxy Server 4.0.4>Start Proxy
Server.

▼ To Stop Proxy Server Service From the Start Menu
Choose Start> Programs >Sun Java Enterprise System 5 >Web Proxy Server 4.0.4>Stop Proxy
Server.

Starting and Stopping Web Server
If you have selected the start servers option in the Finish page of Java ES installer, the Web
Server is started automatically after installation.

▼ To Start the Web Server From the Windows Start Menu
Console

Choose Start > Sun Java Enterprise System 5 > Web Server 7.0 > Start Web Server Administrator
Server.
The cmd screen is displayed.
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▼ To Stop the Web Server From the Windows Start Menu
Console

Choose Start > Sun Java Enterprise System 5 > Web Server 7.0 > Stop Web Server Administrator
Server.
The cmd screen is displayed.

▼ To Start the Web Server Using Web Server
Administration Server

Choose Start > Sun Java Enterprise System 5 > Web Server 7.0 > Administration Console.
The Web Server 7.0 Administration Server Login page appears.

Type the User Name and Password, then click OK.
The Web Server 7.0 Administration Server page appears.

Select a Server from the drop down list, and click Manage.
The Server Manager page appears.

Click Server On.
The Web Server is started and a confirmation dialog box appears.

▼ To Stop the Web Server Using Web Server
Administration Server

Choose Start > Sun Java Enterprise System 5 > Web Server 7.0 > Administration Console.
The Web Server 7.0 Administration Server Login page appears.

Type the User Name and Password, then click OK.
The Web Server 7.0 Administration Server page appears.

Select a Server from the drop down list, and click Manage.
The Server Manager page appears.

Click Server Off.
The Web Server stops and a confirmation dialog box appears.
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▼ To Start the Web Server Using Windows Services
Choose Start > Settings > Control Panel.

Select Administrative Tools.

Select Services.

Select Web Server 7.0 from Services list.
You can use one of the following methods to start the service:

■ Click mouse button 2 and select Start.
■ Click the Start service icon.
■ Click Action Menu and click Start option

Select Sun Java System Web Server 7.0 Administration Server and repeat step 4 to start the Web
Server administration server.

▼ To Start the Web Server Usingstartserv.bat
Change to the WebServer-base\admin-server\bin directory.

Run the startserv.bat command to start the Web Server processes.

▼ To Start the Web Server Instance Using startserv.bat

Change to the WebServer-base\https-[INSTANCE_NAME]\bin directory.

Run the startserv.bat command to start the Web Server processes.

▼ To Stop the Web Server Using Windows Services
Choose Start > Settings > Control Panel.

Select Administrative Tools.

Select Services.

Select Web Server 7.0 from Services list.
You can use one of the following methods to stop the service:
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■ Click mouse button 2 and select Stop.
■ Click the Stop service icon.
■ Select Stop from the Action Menu.

Select Sun Java System Web Server 7.0 Administration Server and repeat step 4 to stop the Web
Server administrator server.

▼ To Stop the Web Server Using stopserv.bat

Change to WebServer-base\https-admserv.

Run the stopserv.bat command to stop the Web Server processes.

▼ To Stop the Web Server Instance Using stopserv.bat

Change to WebServer-base\https-[INSTANCE_NAME].

Run the stopserv.bat command to stop the Web Server processes.

Next Steps
If you have completed this chapter, you have verified that the Java ES components that you
installed and configured are functional. You can now begin administering the Java ES
components. For further information, see the Java ES component documentation at
http://docs.sun.com/app/docs/prod/entsys.5.
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Uninstalling Java ES Components

This chapter provides instructions for uninstalling Sun Java Enterprise System (Java ES)
components that have been installed using the Java ES installer.

This chapter includes the following sections:

■ “How the Uninstaller Works” on page 85
■ “Verifying Prerequisites” on page 87
■ “Reviewing Uninstallation Behavior for Java ES Components” on page 87
■ “Running the Uninstall Program in Graphical Mode” on page 93
■ “Running the Uninstall Program in Silent Mode” on page 94

How the Uninstaller Works
Java ES provides an uninstallation program for removing Java ES components that were
installed on your system by using the Java ES installer.

Limitations of the Uninstaller
Like the Java ES installer, the uninstaller can be run in graphical or silent mode.

■ The uninstaller removes only Java ES components that were installed by the Java ES
installer. To remove Java ES components that were not installed by the Java ES installer,
follow instructions in the Java ES component documentation.

■ The uninstaller must be run separately on each host that contains Java ES components.
Remote uninstallation is not supported. For each host, you can select one or more Java ES
components for removal.

■ The uninstaller might remove configuration and user data files. The files vary for each
component.
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After the uninstallation process is completed, you might have to remove some additional
files and directories. For product-by-product information, refer to “Reviewing
Uninstallation Behavior for Java ES Components” on page 87.

■ The uninstaller checks Java ES component dependencies only for the system on which the
uninstaller is running, issuing warnings when a dependency is discovered.

Handling Interdependencies
The uninstaller might behave differently depending on which Java ES components you installed
and how they are interrelated.
■ The uninstaller recognizes dependencies among products that are installed on the same

host. If you attempt to uninstall a Java ES component that has dependent products installed
on the host, the uninstaller issues a warning.
For example, if you attempt to uninstall Access Manager from the host where Portal Server
is also installed, the uninstaller warns you that Portal Server cannot function without Access
Manager.

■ In most cases, you can uninstall a Java ES component if no other Java ES component
depends on that component.
For example, Portal Server depends on Access Manager but Access Manager does not
depend on Portal Server. If you attempt to uninstall Portal Server, the uninstaller does not
issue a warning because Access Manager can function without Portal Server.

Caution – When uninstalling a Java ES component, you must identify which products are
configured for that Java ES component (some additional configuration might be required).
Otherwise, you could have Java ES components on your system that are configured to support
products that are no longer present.

The uninstaller does not recognize the following interdependencies:

■ Dependencies from remote hosts
■ Dependencies resulting from configuration

Java ES Component Dependencies From Remote Hosts
Some Java ES component dependencies can be satisfied with Java ES components deployed on
remote hosts. The uninstaller does not recognize these dependency relationships.

For example, if you uninstall Directory Server, the uninstaller does not warn you that Access
Manager depends on Directory Server, even if both products are deployed on the same host.
This is because another Directory Server instance on another host could support Access
Manager.

How the Uninstaller Works
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Java ES Component Dependencies Resulting From Configuration
The uninstaller does not recognize a Java ES component dependency that is the result of
postinstallation configuration.

Verifying Prerequisites
The following table lists the tasks that you should perform before uninstallation. Some of the
tasks might not apply to your particular situation.

The left column lists the order in which you should perform the tasks and the right column
contains other useful information and the location of instructions.

TABLE 7–1 Checklist

Task Description Instructions or Helpful Information

1. Review the needs and behaviors of each Java ES component
you plan to uninstall.

“Reviewing Uninstallation Behavior for Java
ES Components” on page 87

2. Identify component dependencies that result from
configuration and take appropriate measures, such as backing
up data, unconfiguring the dependent Java ES component from
the supporting Java ES component, or uninstalling the Java ES
components in the proper order.

“Handling Interdependencies” on page 86

3. Back up or archive configuration or user data for Java ES
components you are uninstalling if you plan to reuse this data
in subsequent installations.

“Reviewing Uninstallation Behavior for Java
ES Components” on page 87

4. Make sure the Directory Server instance that hosts the
configuration directory is running.
Note: In most cases, the web container and Directory Server
should be running, while the other servers should be shut down
before uninstalling.

This Directory Server instance must be
running so that the uninstaller can
unconfigure the Java ES components that
you are uninstalling.

Reviewing Uninstallation Behavior for Java ES Components
Review the relevant tables in this section to see what the uninstaller does with Java ES
components. Plan the steps that you might have to take to prevent loss of data or loss of
interdependency connections.

This section contains the following subsections:

■ “Uninstallation Behavior of Access Manager” on page 88
■ “Uninstallation Behavior of Application Server” on page 88
■ “Uninstallation Behavior of Directory Server ” on page 89
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■ “Uninstallation Behavior of Message Queue” on page 89
■ “Uninstallation Behavior of Monitoring Console” on page 90
■ “Uninstallation Behavior of Service Registry” on page 91
■ “ Uninstallation Behavior of Web Proxy Server” on page 92
■ “Uninstallation Behavior of Web Server ” on page 92

Uninstallation Behavior of Access Manager

TABLE 7–2 Uninstallation Details for Access Manager

Topic Details

Configuration data No entries in Directory Server will be removed (including Access Manager
specific data).

Other installations this
component requires

Directory Server

Web container

Products requiring this
installation

Portal Server (must reside on the same host as Access Manager SDK)

Pre-uninstallation tasks None

Post-uninstallation tasks Uninstallation unconfigures Access Manager from the web container for
full installations on Web Server or Application Server only.

Uninstallation Behavior of Application Server

TABLE 7–3 Uninstallation Details for Application Server

Topic Details

Configuration data and user
data

■ The default domain created during installation is removed during
uninstallation.

■ User-created domains, including all administrative server and
Application Server instances, are not removed during uninstallation.

■ All Administration Server and Application Server instances are stopped
prior to the completion of uninstallation.

Dependencies Requires Message Queue on the same system.

Products requiring this
installation

Components that are configured to use Application Server as web
container: Access Manager, Portal Server.
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TABLE 7–3 Uninstallation Details for Application Server (Continued)
Topic Details

Pre-uninstallation tasks To preserve configuration data, make a copy of the administration domain
directories.

Post-uninstallation To completely remove Application Server from your system, remove any
remaining Application Server log files and directories. The default locations
for Application Server directories is \JavaES-Install-Dir\appserver.

Refer to “Uninstallation Behavior of Message Queue” on page 89 for
information on Message Queue post-uninstallation tasks.

Uninstallation Behavior of Directory Server

TABLE 7–4 Uninstallation Details for Directory Server

Topic Details

Configuration data and user
data

If you are uninstalling the Directory Server instance hosting user data, the
Directory Server LDAP database is removed during uninstallation.

Caution: To avoid loss of data, make sure to back up Directory Server
information before uninstalling. Directory Server has several tools and
utilities to back up Directory Server and migrate configuration data.

Dependencies None

Products requiring this
installation

■ Access Manager
■ Portal Server

Pre-uninstallation Tasks Back up the Directory Server LDAP database as needed.

Post-uninstallation Tasks If you subsequently install Directory Server at the same location, the
installation directory must not exist. You might need to manually remove
the installation directory and any custom configuration files before
reinstalling at the same location.

Uninstallation Behavior of Message Queue

TABLE 7–5 Uninstallation Details for Message Queue

Topic Details

Configuration data Instance-specific configuration data, user repository and access control file
remains after uninstallation, and can be reused upon subsequent
reinstallation.
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TABLE 7–5 Uninstallation Details for Message Queue (Continued)
Topic Details

Other installations this
component requires

Directory Server (optional)

Products requiring this
installation

Application Server (must reside on same host as Message Queue)

Pre-uninstallation tasks ■ Stop any running brokers. You will be prompted for user name (admin)
and password:
imqcmd shutdown bkr [-b hostName:port]

■ If you are not planning to reinstall Message Queue and therefore want
to delete dynamic data, the flat-file user repository, and the access
control file associated with each broker instance, remove this data by
using the following command.
imqbrokerd -name instanceName -remove instance

■ If you upgrade Message Queue by using the Message Queue upgrade
script, make a note of your process. The upgrade script does not write
installation information to the Java ES registry.

Post-uninstallation tasks If you are not planning to reinstall Message Queue, use the commands in
the Java ES component documentation to clean up your system.

Uninstallation Behavior of Monitoring Console

TABLE 7–6 Uninstallation Details for Monitoring Console

Topic Details

Configuration data User data remains after uninstallation. However, this data is removed
before any reinstallation.

Dependencies None

Other products requiring this
installation

None

Pre-Uninstallation Tasks None

Post-Uninstallation Tasks
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Uninstallation Behavior of Portal Server
Please refer the ReadMe file provided with the installer that has information on how to install
and uninstall Portal Server. For more details please
access(http://www.sun.com/download/products.xml?id=465e130d).

Uninstallation Behavior of Service Registry

TABLE 7–7 Uninstallation Details for Service Registry

Topic Details

Configuration data The Registry configuration process installs the Registry database domain
and server keystore in the JavaES-install-dir directory.

The directory is not removed when Service Registry is uninstalled. This
safety mechanism enables you to preserve the database for use in a future
installation or release if you want.

Other installations this
component requires

Application Server (Domain Administration Server and Command-Line
Administration Tool)

HADB

Message Queue

Products requiring this
installation

None

Pre-uninstallation tasks 1. Stop the Service Registry Domain as follows:

JavaES-install-dir\share\ant\bin\ant.bat -f build-install.xml

appserver.domain.stop

2. Delete the Service Registry Domain as follows:

JavaES-install-dir\share\ant\bin\ant.bat -f build-install.xml

appserver.domain.delete

If you want to preserve the Registry database for future use, copy the
ServiceRegistry-base directory to another location before you reinstall the
Registry.
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TABLE 7–7 Uninstallation Details for Service Registry (Continued)
Topic Details

Post-uninstallation tasks If you made a copy of the Registry database, copy the database again after
you reinstall.

After restoring the database and keystore files (stored in the 3.0
directories), run the following command using platform-specific variants:

JavaES-install-dir\share\ant\bin\ant.bat -f build-install.xml

appserver.domain.stop export.registryOperatorCert

install.cacerts appserver.domain.start

This command enables existing users to have continued use of the Service
Registry Web Console.

Uninstallation Behavior of Web Proxy Server

TABLE 7–8 Uninstallation Details for Web Proxy Server

Topic Details

Configuration data Only the certificate database files in the alias directory under the installation
location are preserved. All other files are removed.

Dependencies Directory Server (optional) if external LDAP access control has been
selected.

Pre-uninstallation tasks Stop all instances of Web Proxy Server.

Post-uninstallation tasks The certificate database is preserved under the WebProxyServer-base\alias
directory. You need to move the certificate database and delete the old
installation directory before reinstalling.

Uninstallation Behavior of Web Server

TABLE 7–9 Uninstallation Details for Web Server

Topic Details

Configuration data and user
data

■ Web Server administrative server and Web Server instances are stopped
prior to the completion of the uninstallation.

■ Web Server installation or instance directories can not be removed
without running the uninstaller.

Other installations this
component requires

None
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TABLE 7–9 Uninstallation Details for Web Server (Continued)
Topic Details

Products requiring this
installation

Components that are configured to use Web Server as web container:
Access Manager and Portal Server. Also Application Server Load Balancing
Plug-in (if Application Server uses Web Server as its web container).

Pre-uninstallation tasks None

Post-uninstallation tasks To preserve configuration data, back up the Administrative Server and Web
Server instance directories under the installation location.

If you subsequently install Web Server at the same location, the installation
directory must not exist. You might need to manually remove the
installation directory and any custom configuration files before reinstalling
at the same location.

Running the Uninstall Program in Graphical Mode
After you have completed the relevant tasks in the “Verifying Prerequisites” on page 87, you are
ready to run the uninstall program.

▼ To Start the Windows Wizard/Graphical Uninstall
Program

Choose Start > Settings > Control Panel.

Double-click Add or Remove Programs.

Select Sun Java Enterprise Systems.

Click Change/Remove.
The Welcome page to modify or remove the program appears.

▼ To Modify the Current Installation
Select Modify from the Install shield wizard to add new program features or to remove the
currently installed features.

Click Next.
The Component selection page appears.
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Examine the components.

■ Components that are installed on your system are enabled and can be selected. Components
that are not installed on your system are disabled and cannot be selected.
■ Some components contain subcomponents. Expand the components to view the

subcomponents.
■ If you deselect a component that contains subcomponents, expand the component to

verify the subcomponent list.

Select the components you want to install and deselect the components that you want to
uninstall. Click Next.

The uninstall program modifies the software.

▼ To Remove All the Installed Components
Select Remove from the Install shield wizard.

Click Next.

A confirmation dialog box is displayed.

Click Yes to confirm Remove.

The Setup status page is displayed followed by the Unconfigure dialog box.

Click Yes to confirm unconfiguration of Java ES components.

The products are unconfigured and the servers are stopped and removed.

The Finish page of the wizard is displayed. You can view the summary of installation or
uninstallation details by clicking on View Summary button.

Click Finish to exit the uninstallation wizard.

Running the Uninstall Program in Silent Mode
Silent uninstallation is useful for uninstalling Java ES components on multiple hosts that share
similar configurations. The procedure for uninstalling in silent mode is similar to the procedure
for installing in silent mode as described in Chapter 4, “Installing in Silent Mode.”

3

4

1

2

3

4

5

6

Running the Uninstall Program in Silent Mode

Sun Java Enterprise System 5 Installation Guide for Microsoft Windows • February 200794



▼ To Perform Uninstallation in Silent Mode
Change the directory where the installer is located:
cd JavaES-install-dir

Use the Setup.bat /r command to create the response file.
Use the /f1 option to specify where the response file is to be created and to provide a name. To
avoid unpredictable results, specify an absolute path for the file that has the .iss extension. For
example, type:

Setup.bat /r /f1"C:\Temp\UninstallExample.iss"

All the data typed and options selected are recorded in the .iss file.

The response file is ready for use with the options selected during the record uninstallation. The
response file can be edited manually to modify the options recorded.
You can now use the response file to start silent uninstallation.

Change to the directory where the installer is located.
cd JavaES-install-dir

Type the command Setup.bat /s option to initiate a silent mode uninstallation process.
Use the /f1 option to specify the .iss file location. To avoid unpredictable results, specify an
absolute path. For example, type:

Setup.bat /s /f1"C:\Temp\UninstallExample.iss".

(Optional) Use the /f2option to specify an alternative name and location for the log file. To
avoid unpredictable results, specify an absolute path for the file. For example, type:
Setup.bat /s /f1"C:\Temp\UninstallExample.iss /f2"C:\Setup.log".

While the uninstaller is running, you can monitor its progress by examining changes to the
installation log.
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Troubleshooting

This chapter provides suggestions for how to resolve Sun Java Enterprise System (Java ES)
installation and uninstallation problems.

This chapter includes the following sections:
■ “General Troubleshooting Methods” on page 97
■ “Installation Problems” on page 100
■ “Component Troubleshooting Information” on page 103
■ “Additional Troubleshooting Information” on page 108

General Troubleshooting Methods
This section provides general guidelines for finding the source of a problem. The following
topics are addressed:
■ “Network Connectivity” on page 97
■ “Check Directory Server Connectivity” on page 98
■ “Check Postinstallation Configuration” on page 98
■ “Check Resources and Settings” on page 98
■ “Check the Distribution Media” on page 98
■ “Examine Component Log Files” on page 99
■ “Examine the Installation Log Files” on page 99
■ “Remove Files and Directory” on page 99
■ “Verify Passwords” on page 100
■ “Verify Component Dependencies” on page 100

Network Connectivity
Java ESinstallation is not supported on a stand-alone machine. You must have a machine
connected to a network to install Java ES.

8C H A P T E R 8

97



Check Directory Server Connectivity
If you are installing a component that relies on Directory Server, problems can be caused by one
of these situations:

■ You specified an incorrect user ID and password for Directory Server.
■ You specified an incorrect LDAP port.
■ Directory Server is unreachable.

In Configure Manually After Installation mode, you need to ensure that the Directory Server is
running before configuring the products that depend on Directory Server.

Check Postinstallation Configuration
If you are having problems starting components, verify that the procedures outlined in
Chapter 5, “Completing Postinstallation Configuration” were performed correctly.

Check Resources and Settings
The following host-level issues can cause installation problems:

■ Updates. Have you installed the recommended service packs?
■ Disk space. How is the disk partitioned, and to what partitions do installation directories

point?

■ Network ports. During configuration, you supply port numbers for Java ES components.
Verify that the port information is correct as follows:
■ Examine the standard port numbers in the file.
■ Look at the summary log file to compare your settings with the standards. Did you

mistype a port number or set one server to the port that is typically used for another
port?

■ Use the command netstat -a to view current port use on the system. Did you assign a
port number that was already in use?

■ Check whether you typed the correct Host name and the Domain name during
configuration.

Refer to “System Requirements” on page 22 to check if all the requirements have been met
before proceeding to installation.

Check the Distribution Media
If you are installing from a DVD, examine the media for dirt or damage. Dirty discs can result in
installation problems.
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Examine Component Log Files
If a problem occurs when starting a component, examine its log files. Many component log files
are listed under “Component Troubleshooting Information” on page 103.

Examine the Installation Log Files
If a problem occurs during installation or uninstallation, check the appropriate log file in the
%TEMP%/SunJavaES.log directory.

%TEMP% is the user-defined TEMP folder on that system.

Examining the uninstaller and installer log files (along with the Java ES configuration log) can
help locate the source of problems.

▼ To Examine Installation Log Files

Review the installation summary file, which provides a high-level description of what was
installed and configured. This file is located at JavaEs-install-dir\Summary.txt. If a problem
occurred, check which component caused the problem. If multiple problems occurred, isolate
the first one.

Review the detailed log files.

a. Look for the first error or warning that occurred and attempt to resolve the error. Sometimes
resolving one error resolves a number of seemingly unrelated errors that follow.

b. Find the name of the component that caused the problem.

c. Review the configuration logs. The configuration logs are in component installation
directories. Refer to Summary.txt to find the exact location of component log files.

d. Review the installer log file for installation or uninstallation issues. Refer to configuration
logs for configuration-related issues.

Remove Files and Directory
To prevent the overwriting of customized files, such as edited configuration files, Java ES 5
components cannot be installed in their respective installation directories that contain files.

If you are reinstalling Java ES 5, check the installation directories to ensure that they are empty.
If these directories are not empty, archive the files elsewhere and try the installation again.
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Verify Passwords
The installer requires that you enter a number of passwords for components. If you are
installing different components on different hosts, make sure that you supply matching
passwords on each host.

To resolve password problems, you might need to uninstall and then reinstall. If the
uninstallation fails, refer to “Installation Fails Due to Remaining Files During Uninstallation”
on page 100.

Verify Component Dependencies
A number of components have installation-time interdependencies. Problems that affect one
component can affect other components. To check for interdependencies not met, familiarize
yourself with the information in “Dependency Check” on page 20. Then, do the following:

■ Review the summary file and log files to see whether related components have failed. These
failures might provide a clue as to what to fix first.

■ Check that you have specified correct connection information. For example:
■ Does the information that you provided when configuring Directory Server match the

directory information you provided for components that use Directory Server?
■ Does the Access Manager information that you provided for Portal Server or Portal

Server SRA match the information you provided for Access Manager?

Installation Problems
This section addresses the following problems you might encounter during installation:

■ “Installation Fails Due to Remaining Files During Uninstallation” on page 100
■ “Windows Installer Errors” on page 101
■ “Silent Installation Fails” on page 102
■ “Silent Installation Fails: “Response File Is Incompatible or Corrupted”” on page 102
■ “Unexpected External Errors” on page 102

Installation Fails Due to Remaining Files During
Uninstallation
If uninstallation fails, components that should have been removed might remain on your host
system. In such a case, you must manually remove the components before you reinstall Java ES.
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▼ To Remove Remaining Files
The following cleanup steps are required before reinstalling the Java ESafter a failed installation
or a failed unconfiguration.

Ensure that all the Java ES services are stopped and removed from the Control Panel >
Administrative Tools > Services menu.

Delete any previously installed Sun folder. If you are not able to delete the folder, restart the
system and then delete the folder.

Check for any remaining service entries. If any service entry is remaining in Services, you need to
clean up the registry by removing the entries. Possible entries are listed in the following table.

Component Name Service Entry

Common Agent Container Common Agent Container 2 (#CRC:default)

HADB HADB4.4MgmtAgent

Message Queue MQ3.7UR1_Broker

Portal Server sra.gateway.srainstance

sra.netletproxy.srainstance

sra.rewriterproxy.srainstance

WebAdminServer https-admserv70

Web Console Web Console 3.0.2 console

Web Proxy Server Sun Java System Socks Server 4.0.4 (server1)

Sun Java System Web Proxy Server 4.0.4 (proxy-server1)

Sun Java System Web Proxy Server 4.0.4 Administration Server

Web Server Sun Java System Web Server 7.0 (https-hostname.domainname)

Sun Java System Web Server 7.0 Administration Server

Clean up the registry.
Delete HKEY_LOCAL_MACHINE\Software\Sun Microsystems\Entsys5\Installer.

If you perform any of the previous steps, restart the system before you start the installation.

Windows Installer Errors
Installation can fail due to the following Windows installer error.
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■ Error 1603 - Fatal error during installation: The error occurs if the target host is
Windows 2003 Enterprise Server with SP1. The possible causes of this error are mentioned
at http://support.microsoft.com/default.aspx?scid=kb;en-us;834484.
In such case, you need to install the Update for Windows 2003 Enterprise Server SP1 from
:http://support.microsoft.com/kb/898715.

Silent Installation Fails
If you edited the response file, you might have introduced errors. For example, check the
following:

■ Are all local host parameters set and are they set to consistent values?
■ Are parameter values in the correct case?
■ Did you delete a required parameter without typing a replacement?
■ Are all port numbers valid and unassigned?

Resolve the problem and regenerate the response file as described in “Creating a Response File”
on page 52.

Silent Installation Fails:“Response File Is Incompatible
or Corrupted”
If you are using a response file that was created on the same platform on which you are using the
response file, the problem might be due to an unknown file corruption error. Try to generate a
new response file and reinstall.

For more information, refer to “Creating a Response File” on page 52.

Unexpected External Errors
Possible causes for external errors are the following:

■ Power failure or system failure
■ Pressing Control-C or killing the installer from the task manager to stop the installer process

If the failure occurred during the installation or configuration process, you probably have a
partial installation. Run the uninstallation program. If the uninstallation program fails, follow
the instructions under “Installation Fails Due to Remaining Files During Uninstallation” on
page 100.
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Component Troubleshooting Information
This section provides various quick tips on component troubleshooting, with references to
useful documentation:

■ “Access Manager Troubleshooting Tips” on page 103
■ “Application Server Troubleshooting Tips” on page 104
■ “Directory Server Troubleshooting Tips” on page 104
■ “HADB Troubleshooting Tips” on page 105
■ “Message Queue Troubleshooting Tips” on page 105
■ “Monitoring Console Troubleshooting Tips” on page 106
■ “Portal Server Secure Remote Access Troubleshooting Tips” on page 106
■ “Portal Server Troubleshooting Tips” on page 107
■ “Service Registry Troubleshooting Tips” on page 107
■ “Web Proxy Server Troubleshooting Tips” on page 107
■ “Web Server Troubleshooting Tips” on page 108

Access Manager Troubleshooting Tips

TABLE 8–1 Access Manager Troubleshooting Tips

Topic Details

Configuration File AccessManager-base\Config\AMConfig.properties

Log and Debug Files Log file directory:

AccessManager-base\Logs

Debug file directory:

AccessManager-base\Debug

Debug Mode Refer to the Sun Java System Access Manager
Developer’s Guide.
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Application Server Troubleshooting Tips

TABLE 8–2 Application Server Troubleshooting Tips

Topic Details

Log Files Log file directory:

ApplicationServer-base\Setup\

Application Server instance log directory (default
location for the initially created instance):

JaveES-install-dir\appserver\

Message log file name: server.log, for each server
instance.

Configuration Files Configuration file directory:
ApplicationServer-base\Config.

Troubleshooting Refer to the Sun Java System Application Server
Enterprise Edition Troubleshooting Guide.

Directory Server Troubleshooting Tips

TABLE 8–3 Directory Server Troubleshooting Tips

Topic Details

Log Files Installation log file can be found in tmp folder.

Configuration log files:
■ DirectoryServer-base.Atimestamp
■ DirectoryServer-base.Btimestamp

For information about managing log files, refer to the
Sun Java System Directory Server Administration
Guide

Troubleshooting Refer to the Sun Java System Directory Server
Administration Guide.
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HADB Troubleshooting Tips

TABLE 8–4 HADB Troubleshooting Tips

Topic Details

Log Files ■ HADB.properties

■ mgt.cfg

Executable Location JavaES-install-dir\Hadb\4.4.1-7\lib

Troubleshooting Refer to the High Availability Session Store
Administrator’s Guide.

Message Queue Troubleshooting Tips

TABLE 8–5 Message Queue Troubleshooting Tips

Topic Details

Log Files Installation Log file:

MessageQueue-base\var\instances\instance-name\log

Refer to the Sun Java System Message Queue 3.7 UR1
Administration Guide.

Troubleshooting For performance problems, refer to Chapter 11,
“Analyzing and Tuning a Message Service,” in Sun
Java System Message Queue 3.7 UR1 Administration
Guide.

Message Queue troubleshooting is discussed in
Chapter 12, “Troubleshooting Problems,” in Sun Java
System Message Queue 3.7 UR1 Administration Guide.
and the Message Queue Forum, at:
http://swforum.sun.com/

jive/forum.jspa?forumID=24.

Additional articles are available in Knowledge Base, at
http://developers.sun.com/

prodtech/msgqueue/reference/techart/index.html.
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Monitoring Console Troubleshooting Tips

TABLE 8–6 Monitoring Console Troubleshooting Tips

Topic Details

Configuration Files For Monitoring Console:
■ MonitoringConsole-base\WEB-INF\web.xml

For Monitoring Framework:
■ JavaES-install-dir\share\mfwk\config\mfwk.properties

Log Files For Monitoring Console:
■ JavaES-install-dir\share\webconsole\console\console_config_log

For Monitoring Framework:
■ JavaES-install-dir\share\mfwk\logs

Troubleshooting If you cannot access Monitoring Console, refer to “Troubleshooting the Monitoring
Console” in Sun Java Enterprise System 5 Monitoring Guide. For troubleshooting
Monitoring Console, refer “Troubleshooting the Monitoring Framework” in Sun Java
Enterprise System 5 Monitoring Guide.

Portal Server Secure Remote Access Troubleshooting
Tips

TABLE 8–7 Portal Server Secure Remote Access Troubleshooting Tips

Topic Details

Debug Logs Portal gateway debug logs are located in the
PortalServer-base\debug directory.

Note – Logs for Portal Server services (such as NetFile)
are in AccessManager-base\debug directory when
logging is turned on from Access Manager
Administration Console.
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Portal Server Troubleshooting Tips

TABLE 8–8 Portal Server Troubleshooting Tips

Topic Details

Log Files and Debug Files Portal Server log files are:
■ psadmin logs: PortalServer-base\data\admin

■ Configuration
logsPortalServer-base\data\config

■ Portal Server instance logs: PortalServer-base\
data\portals\portal-id\logs\instance-id

Service Registry Troubleshooting Tips

TABLE 8–9 Service Registry Troubleshooting Tips

Topic Details

Log Files Default log
file:ServiceRegistry-base\domains\registry
\logs\server.log

For more information, refer to the Service Registry 3.1
Administration Guide.

Troubleshooting Refer to the Service Registry 3.1 Administration Guide.

Web Proxy Server Troubleshooting Tips

TABLE 8–10 Web Proxy Server Troubleshooting Tips

Topic Details

Log Files Default log files:
■ JavaES-install-dir\instance-name\config\logs\errors
■ JavaES-install-dir\instance-name\config\logs\access
■ JavaES-install-dir\admin-name\config\logs\errors
■ JavaES-install-dir\admin-name\config\logs\access

For more information, refer Sun Java System Web
Proxy Server Administration Guide.
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TABLE 8–10 Web Proxy Server Troubleshooting Tips (Continued)
Topic Details

Troubleshooting Refer to the Sun Java System Web Proxy
Administration Guide.

Web Server Troubleshooting Tips

TABLE 8–11 Web Server Troubleshooting Tips

Topic Details

Log Files The errors log file and the access log file are located
in the WebServer-base\WebServer_Install.log
directory.

The errors log file lists all the errors that the server
has encountered. The access log records information
about requests to the server and the responses from
the server. For more information, refer to the Sun Java
System Web Server 7.0 Administrator’s Guide.

Troubleshooting Refer to the Sun Java System Web Server 7.0
Troubleshooting Guide.

Configuration File Directory WebServer-base\https-instance-name\config

Additional Troubleshooting Information
The following additional information in this guide is useful for troubleshooting:

■ Chapter 5, “Completing Postinstallation Configuration” contains instruction for
performing postinstallation configuration.

■ Chapter 6, “Verifying Installed Java ES Components” contains instructions to verify
installed Java ES components.

■ Chapter 7, “Uninstalling Java ES Components”contains information about problems that
might occur while uninstalling the Java ES software.
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Java ES Components for This Release

This appendix lists the selectable and shared components that are part of the Sun Java
Enterprise System (Java ES) software.

Java ES Components
In the Component Selection page of the Java ES 5 installer, the Java ES components are grouped
by the services they help to provide. The following list also shows the subcomponents that are
installed with each Java ES component.

■ Sun Java System Portal Server 7.1
■ Sun Java System Portal Server Secure Remote Access 7.1

■ Gateway
■ Netlet Proxy
■ Rewriter Proxy

■ Sun Java System Application Server Enterprise Edition 8.2
■ Domain Administration Server
■ Application Server Node Agent
■ Command Line Administration Tool
■ Load Balancing Plug-in
■ Sample Applications

■ Sun Java System Web Server 7.0
■ Web Server 7.0 CLI
■ Web Server 7.0 Core
■ Web Server Samples

■ Sun Java System Web Proxy Server 4.0.4
■ Sun Java System Message Queue 3.7 UR1
■ Service Registry 3.1
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■ Service Registry Client Support
■ Service Registry Deployment Support

■ Sun Java System Access Manager 7.1
■ Identity Management and Policy Services Core
■ Access Manager Administration Console
■ Common Domain Services for Federation Management
■ Access Manager SDK
■ Distributed Authentication
■ Client SDK
■ Session Failover Client

■ Sun Java System Directory Server Enterprise Edition 6.0
■ Sun Java ES Directory Server 6.0 Core Server
■ Sun Java ES Directory Service Control Center
■ Sun Java System Directory Server Enterprise Edition 6.0 Command-Line Utilities
■ Java Enterprise System Directory Proxy Server 6.0 Core Server

■ Sun Java System Monitoring Console 1.0
■ Java DB 10.2

■ Java DB Server
■ Java DB Client

■ HA Application Server Enterprise Edition (HADB)

Shared Components
Shared components provide the local services and technology support for the Java ES
components. When you install Java ES 5 components, the installer automatically installs the
required shared components if they are not already installed.

This release of Java ES 5 includes these shared components:

■ ANT (Jakarta ANT Java/XML-based build tool) 1.6.6
■ Apache Common Logging (ACL) 1.0.4
■ Berkeley Database (Berkeley DB) 4.2.52
■ Common Agent Container 2.0
■ FastInfoSet 1.0.1
■ International Components for Unicode (ICU) 2 2.1.9
■ ICU 33.2
■ Java 2 Platform, Standard Edition (J2SETM) platform 5.0 Update 9
■ JavaBeansTM Activation Framework (JAF) 1.1
■ Java Studio Web Application Framework (JATO ) 2.1.5
■ JavaHelpTM Runtime 2.0
■ JavaMailTM Runtime 1.4.0

Shared Components
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■ Java API for XML Binding (JAXB) Runtime 2.0
■ Java API for XML Parsing (JAXP) 1.3.1
■ Java API for XML Registries (JAXR ) Runtime 1.0.8
■ Java API for XML-based Remote Procedure Call (JAXRPC) Runtime 1.1.3_01
■ Java API for Web Services (JAXWS) Runtime 1.0.8
■ Java Dynamic Management Kit (JDMK) Runtime 5.1_01
■ Java Security Services (JSS) 4.2.3
■ JSS3 (Network Security Services for Java) 4.6.1
■ JSPTM Standard Library Template (JSTL) 1.0
■ KT Search Engine (KTSE) 1.3.2
■ LDAP C SDK 5.15
■ LDAP Java SDK 4.19
■ Mobile Access (MA) Core 1.0.6
■ Netscape Portable Runtime (NSPR) 4.6
■ Netscape Portable Runtime Development (NSPRD) 4.6
■ Network Security Service (NSS) 3.11
■ Network Security Service Tools (NSSU) 3.11
■ SOAP with Attachments API for Java (SAAJ) 1.3
■ Simple Authentication and Security Layer (SASL) 2.19
■ Monitoring Framework
■ Sun Java Web Console 3.0
■ Web Services Common Library (WSCL) 2.0
■ XML Web Services Security (XWSS)

Shared Components
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Default Directories and Ports

This appendix contains the default directory and port information for the Sun Java Enterprise
System (Java ES) software in the Windows Operating System.

Default Paths and File Names
The following table describes the default paths and file names that are used in this book.

TABLE B–1 Default Paths and File Names

Placeholder Description Default Value

JavaES-install-dir Represents the base installation
directory for Java ES.

C:\Program Files\Sun\JavaES5

AccessManager-base Represents the base installation
directory for Access Manager.

JavaES-install-dir\identity

ApplicationServer-base Represents the base installation
directory for Application Server.

JavaES-install-dir\appserver

DirectoryServer-base
Represents the base installation
directory for Directory Server.

JavaES-install-dir\DSEE

DirectoryProxyServer-base Represents the base installation
directory for Directory Proxy
Server.

JavaES-install-dir\DSEE

HADB-base Represents the base installation
directory for HADB.

JavaES-install-dir\HADB

JavaDB-base Represents the base installation
directory for Java DB.

JavaES-install-dir\JavaDB

BA P P E N D I X B
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TABLE B–1 Default Paths and File Names (Continued)
Placeholder Description Default Value

MessageQueue-base Represents the base installation
directory for Message Queue.

JavaES-install-dir\mq

MonitoringConsole-base Represents the base installation
directory for Monitoring Console.

JavaES-install-dir\jesmc

PortalSever-base Represents the base installation
directory for Portal Server.

C:\Sun\JavaES5\portal

ServiceRegistry-base Represents the base installation
directory for Service Registry.

JavaES-install-dir\srvc-registry

WebServer-base Represents the base installation
directory for Web Server.

JavaES-install-dir\WebServer7

WebProxyServer-base Represents the base installation
directory for Web Proxy Server.

JavaES-install-dir\webproxyserver

Default Port Numbers
When the Java ES installer requests a port number, the installer performs a runtime check on
the ports in use and displays an appropriate default value. If the default port number is being
used by another component or by another instance of the same Java ES component, the installer
presents an alternative value.

The following table lists the default Java EScomponent port numbers and the purpose of each
port.

Note – Portal Server is not listed in this table because the Portal Server uses the port numbering
of the web container into which the Portal Server is deployed.

Default Port Numbers
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TABLE B–2 Default Port Numbers

Component Port Purpose

Application Server 8080 Standard HTTP port

3700 Standard IIOP port

4849 Administration Server port

7676 Standard Message Queue port

8686 JMX port

8181 HTTPS port

Common agent container 11162 JMX port (TCP)

11161 SNMP Adapter port (UDP)

11162 SNMP Adapter port for traps (UDP)

11163 CommandStream Adapter port (TCP)

11164 RMI Connector port (TCP)

Directory Proxy Server 1389 Standard LDAP listener

1636 LDAPS over SSL

Directory Server 1390 Standard LDAP listener

1637 LDAPS over SSL

Directory Server Control
Center

6789 Sun Java Web Console listener

HADB 1862 Management Agent port (JMX)

15200 Default Portbase

Java DB 1527 Also for Apache Derby

Message Queue 80 Standard HTTP port

7676 Port Mapper

7674 HTTPS Tunneling Servlet port

7675 HTTP Tunneling Servlet port

Default Port Numbers
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TABLE B–2 Default Port Numbers (Continued)
Component Port Purpose

Monitoring Console 6789 Accessed through Sun Java Web Console

8765 Job Factories port for Master Agent Web Services Adapter

11161 SNMP port for Monitoring Framework

11164 RMI port for Monitoring Framework

54320 Multicast port for Monitoring Framework discovery
protocol

Portal Server Secure Remote
Access

443 HTTP over SSL

10443 Rewriter Proxy port

10555 Netlet Proxy port

Service Registry 6480 HTTP port

6443 HTTPS port

6484 Message Queue port

6485 IIOP port

6486 IIOP SSL port

6487 IIOP Mutual Authentication port

6488 JMX port

6489 Application Server domain administration port

Web Proxy Server 8888 Administration port

8080 Proxy Instance port

Web Server 8800 Admin HTTP port

8989 Admin SSL port. For Administration Server, SSL port is
required, but HTTP port is optional.

80 Instance HTTP port

Default Port Numbers
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Example Response File: Silent Installation

This appendix contains an example of a response file that has been prepared for a silent
installation.

Example Response File
[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-DlgOrder]

Dlg0={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdWelcome-0

Count=9

Dlg1={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdLicense2-0

Dlg2={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdAskDestPath-0

Dlg3={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdSetupType2-0

Dlg4={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdConfigure-0

Dlg5={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdStartCopy-0

Dlg6={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdStartCopy2-0

Dlg7={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdShowInfoList-0

Dlg8={EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdFinish-0

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdWelcome-0]

Result=1

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdLicense2-0]

Result=1

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdAskDestPath-0]

InstallDir=C:\Program Files\Sun\

Result=1

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdSetupType2-0]

Installation_Type=DEFAULT

Result=304

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdConfigure-0]

Administrator User ID=Admin

Administrator Password=wipro123

RetypePassword=wipro123

Result=1

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdStartCopy-0]
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Result=1

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdStartCopy2-0]

Result=1

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdShowInfoList-0]

Result=1

[{EB05D453-81D0-4F5B-A38C-10C4E6C7DF68}-SdFinish-0]

Result=1

Example Response File
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